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Abstract

This document describes removal and installation of field-replaceable units for Dot Hill AssuredSAN 6004 Series controller 
enclosures, and is intended for use by storage system administrators familiar with servers and computer networks, network 
administration, storage system installation and configuration, storage area network management, and relevant protocols.
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About this guide
Overview

G22x: Added information fro, 

This guide identifies 6004 Series FRUs (field-replaceable units), and describes how to remove or install 
them within the AssuredSAN™ 6004 Series storage enclosure products listed below:

• CNC (Converged Network Controller) Controller enclosure: 6844/6854
• Qualified Fibre Channel SFP option supporting (4/8/16 Gb)
• Qualified Internet SCSI (10GbE) SFP option 
• Qualified Internet SCSI (1 Gb) Copper RJ-45 SFP option

• HD mini-SAS (12 Gb) Controller enclosure: 6544/6554

For a complete description of product models, see the “Components” chapter within the Setup Guide.

AssuredSAN 6004 Series enclosures support both traditional linear storage and new virtual storage, which 
uses paged-storage technology. For linear storage, a group of disks with an assigned RAID level is called 
a vdisk or linear disk group. For virtual storage, a group of disks with an assigned RAID level is called a 
virtual disk group. This guide uses the term vdisk when specifically referring to linear storage, and uses the 
term disk group otherwise.

AssuredSAN 6004 Series enclosure user interfaces
The 6004 Series enclosures support two versions of the web-based application for configuring, monitoring, 
and managing the storage system. Both web-based application GUI versions (v3 and v2), and the 
command-line interface are briefly described:

• Storage Management Console (SMC) is the primary web interface (v3) to manage virtual storage.
• RAIDar is a secondary web interface (v2) to manage linear storage. This legacy interface provides 

certain functionality that is not available in the primary interface.
• The command-line interface (CLI) enables you to interact with the storage system using command syntax 

entered via the keyboard or scripting. You can set a CLI preference to use v3 commands to manage 
virtual storage or to use v2 commands to manage linear storage.

NOTE: For more information about enclosure user interfaces, see the following:
• AssuredSAN Storage Management Guide or online help

The guide describes SMC (v3) and RAIDar (v2) GUIs.
• AssuredSAN CLI Reference Guide

Intended audience
This guide is intended for storage system administrators.

Prerequisites
Prerequisites for installing and using this product include knowledge of:

• Servers and computer networks
• Network administration
• Storage system installation and configuration
• Storage area network (SAN) management and direct attach storage (DAS)
• Fibre Channel (FC), Internet SCSI (iSCSI), Serial Attached SCSI (SAS), and Ethernet protocols
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Related documentation

* Printed document included in product shipkit.

For additional information, see Dot Hill’s Customer Resource Center web site: https://crc.dothill.com.

Document conventions and symbols

CAUTION: Indicates that failure to follow directions could result in damage to equipment or data.

Table 1 Related documents

For information about See

Enhancements, known issues, and late-breaking 
information not included in product documentation

Release Notes

Overview of product shipkit contents and setup tasks Getting Started*

Regulatory compliance and safety and disposal 
information

AssuredSAN Product Regulatory Compliance and Safety*

Using a rackmount bracket kit to install an enclosure 
into a rack

AssuredSAN Rackmount Bracket Kit Installation* document 
pertaining to the specific enclosure model

Attaching or removing an enclosure bezel, and 
servicing the optional air filter

AssuredSAN Enclosure Bezel Kit Installation* document 
pertaining to the specific enclosure model

Product hardware setup and related troubleshooting AssuredSAN 6004 Series Setup Guide

Obtaining and installing a license to use licensed 
features

AssuredSAN Obtaining and Installing a License

Using the v3 and v2 web interfaces to configure and 
manage the product

AssuredSAN Storage Management Guide

Using the command-line interface (CLI) to configure 
and manage the product

AssuredSAN CLI Reference Guide

Event codes and recommended actions AssuredSAN Event Descriptions Reference Guide

Table 2 Document conventions

Convention Element

Blue text Cross-reference links and e-mail addresses

Blue, underlined text Web site addresses

Bold text • Key names
• Text typed into a GUI element, such as into a box
• GUI elements that are clicked or selected, such as menu and list 

items, buttons, and check boxes

Italic text Text emphasis

Monospace text • File and directory names
• System output
• Code
• Text typed at the command-line

Monospace, italic text • Code variables
• Command-line variables

Monospace, bold text Emphasis of file and directory names, system output, code, and text 
typed at the command-line

https://crc.dothill.com
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IMPORTANT: Provides clarifying information or specific instructions.

NOTE: Provides additional information.

TIP: Provides helpful hints and shortcuts.
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1 FRUs
Available FRUs

You can determine which FRUs pertain to your storage enclosure using the Command-line Interface (CLI). 
Access the controller via a Telnet client; log into the controller over the network (default user name manage 
and password !manage). If the default user or password—or both—have been changed for security 
reasons, enter the secure login credentials instead of the defaults shown above.

Enter a show frus query. 

Execution of the show frus CLI command displays controller metadata, followed by the FRU 
information pertaining to chassis (with midplane), I/O modules (IOMs), disk drawers, and power 
supplies.

NOTE: See the AssuredSAN CLI Reference Guide for more information.

You can also determine which FRUs pertain to your storage enclosure by visual inspection of the 
component, noting serial number and part number. This method applies to disk drives. FRUs and FRU 
make-up are subject to change independent of documentation versions. Information about FRUs and other 
components can also be viewed via the SMC or RAIDar.

See Dot Hill’s products: https://www.dothill.com/products page for the latest product information. See the 
customer resource center (CRC) site for interoperability information: https://crc.dothill.com.

Storage enclosure overview

NOTE: Tables and companion illustrations describe field-replaceable units for 6004 Series products. FRUs 
used in 2U12 and 2U24 chassis are addressed in 4004 Series documentation.

Table 3 provides summary descriptions of individual controller enclosure models comprising 6004 Series.

1CNC ports support same-type or mixed-type SFPs in combination as described in Transceivers used in CNC ports on page 67.

Table 3 Individual enclosure models comprising 6004 Series storage systems

AssuredSAN 6004 Series controller enclosure matrix

2.5" 48-drive Controller enclosures: SFF disks in high-capacity drawers (16 drive slots x 3drawers)
3.5" 56-drive Controller enclosures: LFF disks in high-capacity drawers (28 drive slots x 2drawers)

Model Description

6844/6854 Fibre Channel (8/16 Gb) SFP1

This model uses a qualified FC SFP option within the CNC ports (used for host connection or replication). 
When in FC mode, the SFPs must be a qualified 8 Gb or 16 Gb fibre optic option. A 16 Gbit/s SFP can run 
at 16 Gbit/s, 8 Gbit/s, 4 Gbit/s, or auto-negotiate its link speed. An 8 Gbit/s SFP can run at 8 Gbit/s, 4 
Gbit/s, or auto-negotiate its link speed.

6844/6854 Internet SCSI (10GbE) SFP1

This model uses a qualified 10GbE iSCSI option within the controller module CNC ports (used for host 
connection or replication).

6844/6854 Internet SCSI (1 Gb) SFP1

This model uses a qualified 1 Gb iSCSI SFP option within the controller module CNC ports (used for host 
connection or replication).

6544/6554 HD mini-SAS (12 Gb)

This model uses SFF-8644 connectors and qualified cable options for host connection.

https://www.dothill.com/products
https://crc.dothill.com
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FRUs addressing 48-drive enclosures
The high density 2U48 chassis—configured with 48 2.5" disks—is used for 6004 Series contoller 
enclosures and optional expansion enclosures.

The numbered items listed in Table 5 below are pictorially shown in the companion illustrated parts 
breakdown (see Figure 1 on page 14).

Table 4 6004 Series product components for 2U48 enclosures

Item Enclosure component descriptions

1 Enclosure drawer (one drawer shown—pulled forward to drawer stop—included with chassis)

a) Empty drawer chassis assembly (PCBAs, power module and SAS data cable connector)

b) 2.5" disk drive module (disks of differing type/speed and storage capacity: SAS, SSD)

c) Air Management Solution insert (blank to maintain optimum air flow within enclosure) 

2 Ear kit

a) Left ear assembly (exploded view)

b) Right ear assembly (exploded view)

Also see Partial assembly showing bezel alignment with 2U48 chassis on page 17

3 Chassis [with drawer slide and igus chain (data and power cables) shown]

4 Midplane (included with chassis)

5 Power supplies (one AC PSU module shown)

6 Controller module for enclosure [two per controller enclosure] (see Figure 9 on page 20)

a) 6844, 1RM, 4-port CNC, FC [8/16 Gbit/s] SFP option

b) 6844, 1RM, 4-port CNC, iSCSI [10GbE] SFP option

c) 6844, 1RM, 4-port CNC, iSCSI [1 Gbit/s] RJ-45 SFP option

d) 6544, 1RM, HD mini-SAS, 4-port [12 Gbit/s] SFF-8644 external connector

7 Small form-pluggable (SFP) connector (applies to CNC controller modules only)

8 Enclosure cover (included with chassis)

Not 
shown

Expansion module (two per chassis when configured as an expansion enclosure)

J6X48, 1JM, mini-SAS (SFF-8088), 2-port [6 Gbit/s]

Not 
shown

Rail kit [Rack mount rail kit, assembly, All HW]

Not 
shown

Cable kit [Cable package: mini-SAS (SFF-8088) to mini-SAS (SFF-8088)]
Cable kit [Cable package: HD mini-SAS (SFF-8644) to HD mini-SAS (SFF-8644)]
Cable kit [Cable package: HD mini-SAS (SFF-8644) to mini-SAS (SFF-8088)]

Not 
shown

Cable kit [Cable package: USB Type B; CLI (USB)]

Not 
shown

AC power cord compatible with AC power supply unit.
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Figure 1 on page 14 through Figure 5 on page 16 illustrate 48-drive enclosure models. The 2U48 product 
models use an enclosure bezel during operation. The enclosure bezel is only partially shown in Figure 1. 
The enclosure bezel is shown in its entirety in Figure 7 on page 17 (removed) and in Figure 3 on page 15 
(installed).

NOTE: The following illustrations further describe Table 4 components for the 2U48 chassis:
• Controller module pictorial — Figure 2
• Assembly — Figure 3, Figure 4 on page 16, and Figure 7 on page 17
• Internal components sub-assembly — Figure 5 on page 16

Figure 2 6004 Series CNC controller module with SFP transceiver

The transceiver is shown exploded from the IOM in the CNC example. Controller modules equipped with 
CNC ports support qualified FC (8 Gbit/s, 16 Gbit/s), 10GbE iSCSI, and 1 Gb RJ-45 SFP options. 
Controller modules equipped with HD mini-SAS ports use qualified SFF-8644 external connectors.

Figure 3 Enclosure assembly with bezel installed (2U48)

IMPORTANT: Each disk bay must be populated with either a full complement of four disk drive modules, a 
disk bay AMS insert (see Figure 5 on page 16), or a combination of disks and single disk slot AMS inserts 
(see Figure 6 on page 16). Empty disk slots are disallowed.

CNC controller module
(enlarged relative to Figure 1)
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Figure 4 Enclosure assembly with bezel removed (2U48)

Figure 5 Enclosure architecture: internal components sub-assembly (2U48)

The 2U48 enclosure uses AMS inserts within disk bays to manage air flow within the enclosure, and 
maintain an optimal operating temperature. A new AMS is also available for single disk slots.

Figure 6 AMS insert for a single disk slot (2U48)

Drawer handles shown in stowed and pull positions

90°

Disk drive module

Power supply unit

IOM

Midplane

AMS insert

Enclosure drawer

The single disk slot AMS insert
is slated to replace the disk
bay AMS insert over time.
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Enclosure bezel for 48-drive model
The 48-drive 2U48 enclosure supports a bezel sub-assembly that attaches to the front of the chassis (see 
Figure 7 on page 17). The bezel—comprised of a vented cover attached to an EMI (Electromagnetic 
Interference) shield—is pre-assembled and packed with foam into a box included in the master shipping 
container.

Bezel attachment and removal instructions are provided beneath Attaching and removing the enclosure 
bezel on page 25.

Figure 7 Partial assembly showing bezel alignment with 2U48 chassis

NOTE: For information about optional drive enclosure for adding storage, see Supported drive enclosures 
on page 22.

Ball stud on chassis ear
(typical 4 places)

Enclosure bezel sub-assembly
(Includes EMI shield for disks)

Pocket opening (typical 2 places)
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FRUs addressing 56-drive enclosures
The high density 4U56 chassis—configured with 56 3.5" disks—is used for 6004 Series contoller 
enclosures and optional expansion enclosures.

The numbered items listed in Table 5 below are pictorially shown in the companion illustrated parts 
breakdown (see Figure 8 on page 19).

Table 5 6004 Series product components for 4U56 enclosures

Item Enclosure component descriptions

1 Enclosure drawer (shown pulled forward to drawer stop)

a) Empty drawer chassis assembly (PCBAs, power module and SAS data cable connector)

b) 3.5" disk drive module (disks of differing type/speed and storage capacity: SAS, SSD)

2 Ear kit

a) Left ear assembly (exploded view)

b) Right ear assembly (exploded view)

Also see Partial assembly showing bezel alignment with 4U56 chassis on page 22

3 Chassis [with drawer slide and igus chain (data and power cables) shown]

4 Midplane (included with chassis)

5 Power supplies (one shown)

a) AC power supply for enclosure

b) Power supply extension module

6 Igus chainflex assembly (Shown coiled, with unplugged data and power cables. Connectors plug into 
horizontal PCBA at back-end of drawer)

7 Fan Control Module (two per enclosure)

8 Controller module for enclosure [two per controller enclosure] (see Figure 9 on page 20)

a) 6854, 1RM, 4-port CNC, FC [8/16 Gbit/s] SFP option

b) 6854, 1RM, 4-port CNC, iSCSI [10GbE] SFP option

c) 6854, 1RM, 4-port CNC, iSCSI [1 Gbit/s] RJ-45 SFP option

d) 6554, 1RM, HD mini-SAS, 4-port [12 Gbit/s]

9 Small form-pluggable (SFP) connector (applies to CNC controller modules only)

10 Enclosure cover (included with chassis)

Not 
shown

Expansion module (two per chassis when configured as an expansion enclosure)

J6X56, 1JM, mini-SAS (SFF-8088), 2-port [6 Gbit/s]

Not 
shown

Rail kit [Rack mount rail kit, assembly, All HW]

Not 
shown

Cable kit [Cable package: mini-SAS (SFF-8088) to mini-SAS (SFF-8088)]
Cable kit [Cable package: HD mini-SAS (SFF-8644) to HD mini-SAS (SFF-8644)]
Cable kit [Cable package: HD mini-SAS (SFF-8644) to mini-SAS (SFF-8088)]

Not 
shown

Cable kit [Cable package: USB Type B; CLI (USB)]

Not 
shown

AC power cord compatible with AC power supply unit; or
DC power cable compatible with DC power supply unit
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Figure 8 on page 19 through Figure 12 on page 21 illustrate 56-drive enclosure models. The 4U56 product 
models use an enclosure bezel during operation. The enclosure bezel is only partially shown in Figure 8 on 
page 19. The enclosure bezel is shown in its entirety in Figure 13 on page 22 (removed) and in Figure 10 
on page 20 (installed).

NOTE: The following illustrations further describe Table 4 components for the 4U56 chassis:
• Controller module pictorial — Figure 9
• Assembly — Figure 10, Figure 11 on page 21, and Figure 13 on page 22
• Internal components sub-assembly — Figure 12 on page 21

Figure 9 6004 Series CNC controller module with SFP transceiver

The transceiver is shown exploded from the IOM in the CNC example. Controller modules equipped with 
CNC ports support qualified FC (8 Gbit/s, 16 Gbit/s), 10GbE iSCSI, and 1 Gb RJ-45 SFP options. 
Controller modules equipped with HD mini-SAS ports use qualified SFF-8644 external connectors.

Figure 10 Enclosure assembly with bezel installed (4U56)

CNC controller module
(enlarged relative to Figure 1)

AssuredSAN

Vented grille is simplified for clarity
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Figure 11 Enclosure assembly with bezel removed (4U56)

Figure 12 Enclosure architecture: internal components sub-assembly (4U56)

Fan control module
igus chainflex assembly

Disk module

Enclosure drawer

Midplane

IOM

Power supply
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Enclosure bezel for 56-drive model
The 56-drive 4U56 enclosure supports a bezel sub-assembly that attaches to the front of the chassis (see 
Figure 13 on page 22). The bezel—comprised of a vented cover attached to an EMI (Electromagnetic 
Interference) shield—is pre-assembled and packed with foam into a box included in the master shipping 
container. 

Bezel attachment and removal instructions are provided beneath Attaching and removing the enclosure 
bezel on page 25

Figure 13 Partial assembly showing bezel alignment with 4U56 chassis

NOTE: For more information about servicing or replacing the removable air filter option for this particular 
bezel, refer to the Enclosure Bezel Kit Installation instructions included in your product ship kit.

Supported drive enclosures

1These 6004 Series-compatible expansion enclosure models feature 6 Gbit/s internal disk and SAS expander link speeds. See the 
4004 Series Setup and FRU guides for information about 2U24 and 2U12 enclosures

2See the AssuredSAN 6004 Series Setup Guide—and this guide—for information about the high-capacity 4U56 chassis form factor.
3See the 6004 Series Setup Guide for maximum enclosure limits and associated cabling configurations.
4The 6004 Series 4U56 enclosures are designed for NEBS compliance; however, the 6004 Series 2U48 enclosures are not.
5See https://www.dothill.com for most current information concerning support of drive enclosures for storage expansion.

AssuredSAN

Vented grille is simplified for clarity

Back

Back

Slotted angle bracket

Sleeve

Front

Table 6 Compatible drive enclosures for adding storage

Model Form Enclosure description Disk drives Rear panel connection NEBS

J6X56 4U56 56-drive 6 Gbit/s chassis with FRUs 2.5" (SFF) mini-SAS to mini-SAS Note 4

J6X48 2U48 48-drive 6 Gbit/s chassis with FRUs 3.5" (LFF) mini-SAS to mini-SAS Note 4
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2 Procedures
This chapter provides procedures for replacing FRUs (field-replaceable units), including precautions, 
removal instructions, installation instructions, and verification of successful installation. Each procedure 
addresses a specific task. Certain procedures refer to related documentation. See Related documentation 
on page 10 for a list of these documents and where to find them online.

IMPORTANT: Procedures pertain to FRUs used in 6004 Series (2U48 & 4U56) products.

Electrostatic discharge
Before you begin any of the procedures, consider the following precautions and preventive measures. 

Preventing electrostatic discharge
To prevent electrostatic discharge (ESD) from damaging the system, be aware of the precautions to 
consider when setting up the system or handling parts. A discharge of static electricity from a finger or 
other conductor may damage system boards or other static-sensitive devices. This type of damage may 
reduce the life expectancy of the device.

CAUTION: Parts can be damaged by electrostatic discharge. Follow these precautions:
• Avoid hand contact by transporting and storing products in static-safe containers.
• Keep electrostatic-sensitive parts in their containers until they arrive at static-protected workstations.
• Place parts in a static-protected area before removing them from their containers.
• Avoid touching pins, leads, or circuitry.
• Always be properly grounded when touching a static-sensitive component or assembly.
• Remove clutter (plastic, vinyl, foam) from the static-protected workstation.

Grounding methods to prevent electrostatic discharge
Several methods are used for grounding. Adhere to the following precautions when handling or installing 
electrostatic-sensitive parts.

CAUTION: Parts can be damaged by electrostatic discharge. Use proper anti-static protection:
• Keep the replacement FRU in the ESD bag until needed; and when removing a FRU from the enclosure, 

immediately place it in the ESD bag and anti-static packaging.
• Wear an ESD wrist strap connected by a ground cord to a grounded workstation or unpainted surface 

of the computer chassis. Wrist straps are flexible straps with a minimum of 1 megohm (± 10 percent) 
resistance in the ground cords. To provide proper ground, wear the strap snug against the skin.

• If an ESD wrist strap is unavailable, touch an unpainted surface of the chassis before handling the 
component.

• Use heel straps, toe straps, or boot straps at standing workstations. Wear the straps on both feet when 
standing on conductive floors or dissipating floor mats.

• Use conductive field service tools.
• Use a portable field service kit with a folding static-dissipating work mat.

If you do not have any of the suggested equipment for proper grounding, have an authorized reseller 
install the part. For more information about static electricity or assistance with product installation, contact 
an authorized reseller.
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Replacing chassis FRU components
Replacing chassis FRU components

Chassis FRUs replace a damaged chassis or chassis components. A fully functional chassis requires 
successful installation of the following components: 

• Two controller modules of the same model (for a given controller enclosure)*
See Replacing a controller module or expansion module on page 26 for more information.

• All disk drives and air management modules.
See Replacing a disk drive module on page 41 for more information.

• Two power supply modules of the same type (both AC or both DC)
See Replacing a power supply module on page 50 for more information.

• Two fan control modules (4U56 models only)
See Replacing a fan control module on page 59 for more information.

• Two ears with components installed (complementary left and right ear kits)
See Replacing ear components on page 63 for more information.

NOTE: Newer product models use an enclosure bezel instead of ear covers.
• See Figure 14 on page 25 for 2U enclosure bezel alignment.
• See Figure 15 on page 26 for 4U enclosure bezel alignment.

• Two expansion modules of the same model (per optional expansion enclosure)*
See Replacing a controller module or expansion module on page 26 for more information.

*Each I/O module (IOM) slot within the chassis must contain an IOM to enable sufficient air flow through the enclosure 
during operation. Whether configured as a controller enclosure or a drive enclosure, the 6004 Series chassis supports 
dual-controller configuration only. Single-controller support is provided only when a controller fails over to its partner 
controller.

In addition to the FRUs identified above, replacement procedures are provided to address specific interface 
protocols and replacement of the enclosure chassis:

• Removal and installation of a Fibre Channel transceiver
See Replacing a Fibre Channel transceiver on page 67 more information.

• Removal and installation of a 10GbE SFP+ transceiver
See Replacing a 10GbE SFP+ transceiver on page 70 for more information.

• Removal and installation of a 1 Gb RJ-45 SFP transceiver
See Replacing a 1Gb RJ-45 SFP transceiver on page 70 for more information.

• Removal and installation of a storage enclosure chassis
See Replacing a storage enclosure chassis on page 71 for more information.

Replacement of chassis FRU components are described within this chapter.

NOTE: AssuredSAN 6004 Series controller enclosures support hot-plug replacement of redundant 
controller modules, fans, power supplies, and I/O modules. Hot-add of drive enclosures is also supported. 

TIP: Many procedures refer to component LEDs and LED statuses. See the AssuredSAN 6004 Series 
Setup Guide for descriptions of model-specific front panel and rear panel LEDs.
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TIP: Within the AssuredSAN 6004 Series Setup Guide, see “Troubleshooting > Fault isolation 
methodology” for information about using health icons/values—in addition to using LEDs—for verifying 
component failure before actually replacing the FRU.

Attaching and removing the enclosure bezel
Before accessing front panel LEDs, you must first remove the enclosure bezel. 

Figure 14 Partial assembly showing bezel alignment (2U)

Attaching the enclosure bezel (2U)
1. Orient the bezel to align its back side with the front face of the enclosure as shown in the figures above.
2. Face the front of the enclosure, and while supporting the base of the bezel, position it such that the 

mounting sleeves within the integrated ear caps align with the ball studs.
3. Gently push-fit the bezel onto the ball studs to attach the bezel to the front of the enclosure.

Removing the enclosure bezel (2U)
1. While facing the front of the enclosure, insert the index finger of each hand into the top of the 

respective (left or right) pocket opening shown in the figures above.
2. Insert the middle finger of each hand into the bottom of the respective opening, with thumbs on the 

bottom of the bezel face.
3. Gently pull the top of the bezel while applying slight inward pressure below, to release the bezel from 

the ball studs.

NOTE: Instructions for attaching and removing the 4U56 enclosure bezel follow Figure 15.

Ball stud on chassis ear
(typical 4 places)

Enclosure bezel sub-assembly
(Includes EMI shield for disks)

Pocket opening (typical 2 places)
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Before accessing front panel LEDs, you must first remove the enclosure bezel.

Figure 15 Partial assembly showing bezel alignment (4U)

Attaching the enclosure bezel (4U)
1. Orient the bezel to align its back side with the front face of the enclosure as shown in the figure above.
2. Tilt the bezel forward, and guide the two angle-bracket slots on the backside of the bezel onto the two 

upturned flanges located on sidemount brackets near the front of the enclosure (on the exterior left and 
right chassis walls).

3. Gently push-fit the bezel onto the ball studs to attach the bezel to the front of the enclosure.

Removing the enclosure bezel (4U)
1. While facing the front of the enclosure, insert the index finger of each hand into the top of the 

respective (left or right) pocket opening shown in the figure above.
2. Gently pull the top of the bezel while applying slight inward pressure below to release the top sleeves 

from the ball studs.
3. Lift the bezel upwards to allow the angle-bracket slots to clear the upturned mounting flanges.

Replacing a controller module or expansion module
In a dual-controller configuration, controller and expansion modules are hot-swappable, which means you 
can replace one module without halting I/O to disk groups, or powering off the enclosure. In this case, the 
second module takes over operation of the storage system until you install the new module.

You may need to replace a controller module or an expansion module when:

• The Fault/Service Required LED is illuminated
• Health status reporting in the SMC or RAIDar indicates a problem with the module
• Events in RAIDar indicate a problem with the module
• Troubleshooting indicates a problem with the module

NOTE: 6004 Series controller enclosures equipped with CNC controller modules support the 
optionally-licensed AssuredRemote™ replication feature; whereas enclosures equipped with SAS controller 
modules do not.

AssuredSAN

Vented grille is simplified for clarity

Back

Back

Slotted angle bracket

Sleeve

Front
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CAUTION: When replacing an 6004 Series controller set supporting AssuredRemote with an 6004 Series 
controller set that does not support this licensed feature, you must first delete all replication sets before 
swapping the controller modules. Not doing so will lead to unexpected results, and there is no way to 
delete replication sets after the installation. See the following for additional information:
• AssuredSAN Storage Management Guide
• AssuredSAN CLI Reference Guide

Before you begin
Removing a controller or expansion module from an operational enclosure significantly changes air flow 
within the enclosure. Openings must be populated for the enclosure to cool properly. Leave modules in the 
enclosure until ready to install a replacement. If replacing both controllers in the dual-control enclosure, use 
the SMC or RAIDar to record configuration settings before installing the new controller modules. See 
Removing a controller module or expansion module on page 31, and Installing a controller module or 
expansion module on page 33 for instructions.

CAUTION: When replacing a controller module, ensure that less than 10 seconds elapse between 
inserting it into a slot and fully latching it in place. Not doing so might cause the controller to fail. If it is not 
latched within 10 seconds, remove the controller module from the slot, and repeat the process.

The two controller modules installed in the enclosure must be of the same model type. When replacing 
both controller modules in an operational enclosure, follow these guidelines:

1. Replace one controller as described in these instructions.
2. Wait 30 minutes: this pause ensures that the controller and its ownership of disk groups has sufficient 

time to stabilize (also see Verifying component operation on page 35).
3. Check the system status and event logs to verify that the system is stable.
4. Replace the partner controller as described in these instructions.

Configuring partner firmware update
In a dual-controller system in which Partner Firmware Update (PFU) is enabled, when you update firmware 
on one controller, the system automatically updates the partner controller. Disable partner firmware update 
only if requested by a service technician.

Use the SMC, RAIDar, or the CLI to change the PFU setting.

Using the SMC or RAIDar

IMPORTANT: See the “Updating firmware” topic within the AssuredSAN Storage Management Guide 
before performing a firmware update.

To change the PFU setting using the SMC (v3):

1. Sign-in to the SMC using default user manage and password !manage.
If the default user or password—or both—have been changed for security reasons, enter the secure 
login credentials instead of the system defaults shown above.

2. In the System topic, select Action > Update Firmware.
The Update Firmware panel opens. The Update Controller Modules tab shows versions of firmware 
components that are currently installed in each controller.
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NOTE: The SMC does not provide a check-box for enabling or disabling Partner Firmware Update for 
the partner controller. To enable or disable the setting, use the set advanced-settings 
command, and set the partner-firmware-upgrade parameter. See the CLI Reference Guide 
for more information about command parameter syntax. Also see Using the CLI on page 28.

To change the PFU setting using RAIDar (v2):

1. Sign-in to RAIDar using default user manage and password !manage.
If the default user or password—or both—have been changed for security reasons, enter the secure 
login credentials instead of the system defaults shown above.

2. Click in the Configuration View panel, right-click the system and select Configuration > Advanced 
Settings > Firmware.

3. Either select (check) the Partner Firmware Update check box to enable the option, or clear the check 
box to disable the option.

4. Click Apply.

Using the CLI
You can set a CLI preference to use v3 commands to manage virtual storage or to use v2 commands to 
manage linear storage.

TIP: The following CLI commands enable you to set the management mode to v3 or v2:
• Use set protocols to change the default management mode.
• Use set cli-parameters to change the current management mode for the CLI session.

See the CLI Reference Guide for more information

1. Log-in to the command-line interface using default user manage and password !manage.
If the default user or password—or both—have been changed for security reasons, enter the secure 
login credentials instead of the system defaults shown above. 

2. To verify that partner firmware upgrade is enabled, run the following command:
show advanced-settings

3. If partner firmware upgrade is disabled, enable it by running the following command:
set advanced-settings partner-firmware-upgrade enabled

NOTE: See the AssuredSAN CLI Reference Guide for additional information.

Verifying component failure
Select from the following methods to verify component failure:

• Use the SMC or RAIDar to check the health icons/values of the system and its components to either 
ensure that everything is okay, or to drill down to a problem component. The SMC and RAIDar use 
health icons to show OK, Degraded, Fault, or Unknown status for the system and its components. If you 
discover a problem component, follow the actions in its Health Recommendations field to resolve the 
problem.

• As an alternative to using the SMC or RAIDar, you can run the show system command in the CLI to 
view the health of the system and its components. If any component has a problem, the system health 
will be Degraded, Fault, or Unknown. If you discover a problem component, follow the actions in its 
Health Recommendations field to resolve the problem.

• Monitor event notification — With event notification configured and enabled, use the SMC or RAIDar 
to view the event log, or use the CLI to run the show events detail command to see details for 
events.
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• Check Fault/Service Required LED (back of enclosure): Amber = Fault condition
• Check that the FRU OK LED (back of enclosure) is off

Stopping I/O
When troubleshooting disk drive and connectivity faults, stop I/O to the affected disk groups from all hosts 
and remote systems as a data protection precaution. As an additional data protection precaution, it is 
helpful to conduct regularly scheduled backups of your data.

IMPORTANT: Stopping I/O to a disk group is a host-side task, and falls outside the scope of this 
document.

When on-site, you can verify that there is no I/O activity by briefly monitoring the system LEDs; however, 
when accessing the storage system remotely, this is not possible. Remotely, you can use the show 
disk-group-statistics command to determine if input and output has stopped. Perform these steps:

1. Using the CLI, run the show disk-group-statistics command.
The Reads and Writes outputs show the number of these operations that have occurred since the 
statistic was last reset, or since the controller was restarted. Record the numbers displayed.

2. Run the show disk-group-statistics command a second time.
This provides you a specific window of time (the interval between requesting the statistics) to determine 
if data is being written to or read from the disk. Record the numbers displayed.

3. To determine if any reads or writes occur during this interval, subtract the set of numbers you recorded 
in step 1 from the numbers you recorded in step 2.
• If the resulting difference is zero, then I/O has stopped.
• If the resulting difference is not zero, a host is still reading from or writing to the disk group. 

Continue to stop I/O from hosts, and repeat step 1 and step 2 until the difference in step 3 is zero.

NOTE: See the AssuredSAN CLI Reference Guide for additional information.

Shutting down a controller module
Shutting down the Storage Controller in a controller module ensures that a proper failover sequence is 
used, which includes stopping all I/O operations and writing any data in write cache to disk. If the 
Storage Controller in both controller modules is shut down, hosts cannot access the system’s data. Perform 
a shut down before you remove a controller module from an enclosure, or before you power off its 
enclosure for maintenance, repair, or a move.

CAUTION: You can continue to use the CLI when either or both Storage Controllers are shut down, but 
information shown might be invalid.

Use the SMC, RAIDar, or the CLI to perform a shut down.

Using the SMC or RAIDar
To shut down using the SMC (v3):

1. Sign-in to the SMC using default user manage and password !manage.
If the default user or password—or both—have been changed for security reasons, enter the secure 
login credentials instead of the system defaults shown.

2. In the System topic, select Action > Restart System.
The Controller Restart and Shut Down panel opens.

3. Select the Shut Down operation, which automatically selects the controller type Storage.
4. Select the controller module to shut down: A, B, or both.
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5. Click OK. A confirmation panel appears.
6. Click Yes to continue; otherwise, click No. If you clicked Yes, a message describes shutdown activity.

NOTE: If an iSCSI port is connected to a Microsoft Windows host, the following event is recorded 
in the Windows event log: Initiator failed to connect to the target.

To shut down using RAIDar (v2):

1. Sign-in to RAIDar using default user manage and password !manage.
If the default user or password—or both—have been changed for security reasons, enter the secure 
login credentials instead of the system defaults shown above.

2. In the Configuration View panel, right-click the system and select Tools > Shut Down or Restart 
Controller.
The Shut Down or Restart Controller panel appears.

3. In the Shut Down or Restart Controller panel, set the options:
• Operation: select Shut down.
• Controller type: select Storage.
• Within the Controller field, select A, B, or Both.

4. Click Shut down now. A confirmation dialog appears.
5. Click Yes to continue; otherwise, click No. If you clicked Yes, a second confirmation dialog appears.
6. Click Yes to continue; otherwise, click No. If you clicked Yes, a message describes shutdown activity.

NOTE: If an iSCSI port is connected to a Microsoft Windows host, the following event is recorded 
in the Windows event log: Initiator failed to connect to the target.

NOTE: See the AssuredSAN Storage Management Guide for additional information.

Using the CLI
You can set a CLI preference to use v3 commands to manage virtual storage or to use v2 commands to 
manage linear storage. 
See the TIP bullets regarding CLI “default management mode” and “current management mode” page 28.

1. Log-in to the CLI using default user manage and password !manage.
If the default user or password—or both—have been changed for security reasons, enter the secure 
login credentials instead of the system defaults shown above. 

2. In a dual-controller system, verify that the partner controller is online by running the command:
show controllers

3. Shut down the failed controller—A or B—by running the command:
shutdown a or shutdown b

The blue OK to Remove LED (back of enclosure) illuminates to indicate that the controller module can 
be safely removed.

4. Illuminate the identification LED of the enclosure that contains the controller module to remove by 
running the command:
set led enclosure 0 on

NOTE: See the AssuredSAN CLI Reference Guide for additional information.
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Removing a controller module or expansion module

IMPORTANT:
• In dual-controller configurations featuring one healthy partner controller, there is no need to 

transport failed controller cache to a replacement controller because the cache is duplicated 
between the controllers (subject to volume write optimization setting).

• 6004 Series enclosures support dual-controller environments only. Do not transport the 
CompactFlash since data corruption might occur. Single-controller support is provided only when a 
controller fails over to its partner controller.

• In a dual-controller environment, you may hot-replace a single controller module in an operational 
enclosure, provided you first shut down the faulty controller using the SMC, RAIDar, or the CLI.

• In a dual-controller environment—if replacing both controller modules—you must adhere to the 
instructions provided in Before you begin on page 27.

See the CAUTION bullets regarding “electrostatic discharge” and “anti-static protection” page 23.

NOTE: Within these procedures, illustrations featuring controller module face plates are generic. They do 
not show host interface ports, and they pertain to all 6004 Series controller module models. For 
illustrations of model-specific controller face plates, see the AssuredSAN 6004 Series Setup Guide.

Illustrations in the controller module replacement procedures show rear panel views of the enclosure, and 
IOMs are properly aligned for insertion into the rear panel of the enclosure. 

1. Verify that you have successfully shut down the controller module using the SMC, RAIDar, or the CLI.
2. Locate the enclosure whose Unit Locator LED (front right ear) is illuminated, and within the enclosure, 

locate the controller module whose OK to Remove LED is blue (rear panel).
3. Disconnect any cables connected to the controller.

Label each cable to facilitate re-connection.
4. Turn the thumbscrews counterclockwise until they disengage from the controller (see Figure 16 on 

page 31).

Figure 16 Disengaging a controller module
5. Press both latches downward to disconnect the controller module from the midplane (see Figure 17).
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Figure 17 Extracting a controller module
6. Pull the controller module straight out of the enclosure such that the controller module remains level 

during removal (see Figure 18 and Figure 19).

Figure 18 Removing a controller module (2U)
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Figure 19 Removing a controller module (4U)

Installing a controller module or expansion module

TIP: You can install a controller module into an enclosure that is powered on, provided you wait 60 
seconds after removing the old controller module. Check controller and midplane power connectors before 
inserting the new controller module into the enclosure.

See the CAUTION bullets regarding “electrostatic discharge” and “anti-static protection” on page 23.

1. Loosen the thumbscrews; press the latches downward (see Figure 20 or Figure 21 on page 34).
2. Ensuring that the controller module is level, slide it into the enclosure as far as it will go (1).

A controller module that is only partially-seated will prevent optimal performance of the controller 
enclosure. Verify that the controller module is fully-seated before continuing. 

3. Press the latches upward to engage the controller module (2); turn the thumbscrews clockwise until 
finger-tight.

4. Reconnect the cables.
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NOTE: See the AssuredSAN 6004 Series Setup Guide for cabling information.

Figure 20 Inserting a controller module (2U)

Figure 21 Inserting a controller module (4U)

IMPORTANT: In a dual-controller system in which PFU is enabled, when you update firmware on one 
controller, the system automatically updates the partner controller.

1

2

2
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Verifying component operation
After replacing the controller module, verify that the FRU OK LED (rear panel) illuminates green, indicating 
that the controller has completed initializing, and is online/operating normally. It may take two to five 
minutes for the replacement controller to become ready. If you are replacing either controller module, and 
PFU is enabled, you may need to wait 30 minutes to ensure that the two controllers—with their respective 
ownership of the vdisks or disk groups—have enough time to fully stabilize. 

Use the SMC, RAIDar, or the CLI to perform a restart only if necessary.

IMPORTANT: Use the SMC, RAIDar, or the CLI to perform a restart only if necessary. See the “Restarting 
controllers” topic in the Storage Management Guide for more information.

Using the SMC or RAIDar
To restart the controller using the SMC (v3):

1. Sign-in to the SMC using default user manage and password !manage.
If the default user or password—or both—have been changed for security reasons, enter the secure 
login credentials instead of the system defaults shown.

2. In the System topic, select Action > Restart System.
The Controller Restart and Shut Down panel opens.

3. Select the Restart operation.
4. Select the controller type to restart: Management or Storage.
5. Select the controller module to shut down: A, B, or both.
6. Click OK. A confirmation panel appears.
7. Click Yes to continue; otherwise, click No. If you clicked Yes, a message describes shutdown activity.

NOTE: If an iSCSI port is connected to a Microsoft Windows host, the following event is recorded 
in the Windows event log: Initiator failed to connect to the target.

To restart the controller using RAIDar (v2):

1. Sign-in to RAIDar using default user manage and password !manage.
If the default user or password—or both—have been changed for security reasons, enter the secure 
login credentials instead of the system defaults shown above.

2. In the Configuration View panel, right-click the system and select Tools > Shut Down or Restart 
Controller.

3. In the main panel, set the options:
• Operation: Select Restart.
• Controller Type: Select the controller type to restart: Management or Storage.
• Controller: Select the controller module to restart: A, B, or Both.

4. Click Restart now. A confirmation panel appears.
5. Click Yes to continue; otherwise, click No. If you click Yes, a second confirmation diagram appears.
6. Click Yes to continue; otherwise, click No. If you click Yes, a message describes restart activity.

NOTE: If an iSCSI port is connected to a Microsoft Windows host, the following event is recorded 
in the Windows event log: A connection to the target was lost, but Initiator 
successfully reconnected to the target.
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Using the CLI
You can set a CLI preference to use v3 commands to manage virtual storage or to use v2 commands to 
manage linear storage.
See the TIP bullets regarding CLI “default management mode” and “current management mode” page 28.

If the enclosure’s Unit Locator LED is on, run the following command to turn it off:

set led enclosure 0 off

If the Fault/Service Required LED is amber, the controller module has not gone online, and likely failed its 
self-test. Put the module online by restarting the controller, or by checking the event log for errors.

To restart the Management Controller (A or B), run the following command:

restart mc a or restart mc b or restart mc both
To restart the Storage Controller (A or B), run the following command:

restart sc a or restart sc b or restart sc both

TIP: See the AssuredSAN 6004 Series Setup Guide for descriptions of model-specific LEDs.

Updating firmware
You can view the current versions of firmware in controller modules, expansion modules (in drive 
enclosures), and disks (in drawers), and you can also install new firmware versions.

TIP: To ensure success of an online update, select a period of low I/O activity. This helps the update 
complete as quickly as possible and avoids disruptions to hosts and applications due to timeouts. 
Attempting to update a storage system that is processing a large I/O-intensive batch job will likely cause 
hosts to lose connectivity with the storage system.

6004 Series enclosures are configured with dual-IOMs. In a dual-controller system, both I/O modules 
should run the same firmware version. Storage systems in a replication set must run compatible firmware 
versions. You can update the firmware in each IOM by loading a firmware file obtained from the enclosure 
vendor.

If the PFU option is enabled, when you update one controller, the system automatically updates the partner 
controller. If PFU is disabled, after updating firmware on one controller, you must log into the partner 
controller’s IP address and perform this firmware update on that controller also. 

NOTE: If a vdisk (v2) or disk group (v3) is quarantined, firmware update is not permitted due to the risk of 
losing unwritten data that remains in cache for the vdisk or disk group. Before you can update firmware, 
you must resolve the problem causing the quarantine, as described in the Storage Management Guide, 
online help, or the CLI Reference Guide (see dequarantine CLI command).

For best results, the storage system should be in a healthy state before starting firmware update. You can 
update firmware using the SMC, RAIDar, or by using FTP (File Transfer Protocol). See the Storage 
Management Guide for more information.

IMPORTANT: See the “Updating firmware” topic within the AssuredSAN Storage Management Guide 
before performing a firmware update.
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Accessing drawers
Accessing a 2U16 drawer

The 2U48 enclosure includes two different drawers; one for the left (Drawer 0) and middle (Drawer 1) 
drawers, and one for the right (Drawer 2) drawer. See Appendix A — Drawer description for 2U48 chassis 
for a summary overview of disk slot numbering and drawer-loading requirements for 2U48 enclosure.

Opening and closing a 2U16 drawer
You can open a drawer for visual inspection of disks while the drawer is in operation. Before accessing the 
drawer via its handle, you must first remove the enclosure bezel (see narrative instructions beneath 
Figure 14 on page 25). Given that the enclosure bezel is required to provide EMI protection, you should 
re-attach the bezel to the enclosure after examining the drawer.

1. Using a Torx T15 or straight blade screwdriver, loosen the drawer stop screw on the front face of the 
drawer (see Loosen the drawer stop screw (2U48) on page 37).
Once the screw is loosened, use the outer thumb wheel to unlock the drawer. Do not remove the screw.

Figure 22 Loosen the drawer stop screw (2U48)

2. Revolve the drawer handle upwards by 90to enable pulling the drawer outward for viewing disks (see 
Revolve the handle to drawer-pull position (2U48) on page 37).

Figure 23 Revolve the handle to drawer-pull position (2U48)

3. Face the front of the drawer—and using the handle—pull the drawer outward along the drawer slide 
until it meets the drawer stop. 
See Opening and closing a 2U16 drawer: pull or push drawer along slide (2U48) on page 38.

1 20

Enclosure front panel with bezel removed showing left (0), middle (1), and right (2) drawers

Loosen screw on target drawer

90°

The drawer handle functions identically on all drawers.
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The open drawer that shown in the example is empty. 

Figure 24 Opening and closing a 2U16 drawer: pull or push drawer along slide (2U48)

To close the drawer, simply slide the drawer into the enclosure along the drawer slide until it properly seats 
in the drawer bay. Take care to ensure there are no loose cable wires protruding beyond the limits of the 
igus chainflex cable. After closing the drawer, revolve the handle downwards such that it is flush with the 
drawer front panel—in its stowed position—and re-attach the bezel to the front of the enclosure.

Aligning an AMS or disk module for installation into a 2U16 drawer
Once you have opened the drawer, you can access the disk bays. The enclosure uses an SFF sledded disk 
positioned to lay on its side—with the disk PCBA facing up—for insertion into the disk slot within the 
drawer. Each disk is mated to a connector on the drawer PCBA. In the absence of quantity-four disks, the 
enclosure uses an Air Management Solution (AMS) insert within disk bays to manage air flow within the 
enclosure, to help maintain optimal operating temperature. A new AMS insert is also available for single 
disk slots.

NOTE: For more information about AMS inserts, see Air management solution insert on page 42.

Figure 25 Align AMS or disk module for installation into the 2U16 drawer

90°

Disk

AMS
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IMPORTANT: Each disk bay must be populated with either a full complement of disk drive modules, a disk 
bay AMS insert (shown above), or a combination of disks and single disk slot AMS inserts (see Figure 30 
on page 43). Empty disk slots are disallowed.

Accessing a 4U28 drawer
The 4U56 enclosure includes two different drawers; one for the left drawer bay (Drawer 0), and one for the 
right drawer bay (Drawer 1). See the Drawer description for 2U48 chassis appendix for a summary 
overview of disk slot numbering and drawer-loading requirements for 4U56 enclosures.

Opening and closing a 4U28 drawer
You can open a drawer for visual inspection of disks while the drawer is in operation. Before accessing the 
drawer via its handle, you must first remove the enclosure bezel (see narrative instructions following 
Figure 15 on page 26). Given that the enclosure bezel is required to provide EMI protection, you should 
re-attach the bezel to the enclosure after examining the drawer.

1. Using a Torx T15 or straight blade screwdriver, loosen the two screws securing the handle to the front 
face of the drawer (see Loosen the drawer stop screw (4U56) on page 40).
Once the two screws on the target drawer are loosened, turn the thumbwheel counter-clockwise to 
disengage the handle from its upright stowed position.

2. Move the drawer toggle to enable the target drawer to travel along the slide.
Move the toggle to the right to open Drawer 0 (left drawer); or move the toggle to the left to open 
Drawer 1 (right drawer).

3. Revolve the drawer handle downwards by 90to enable pulling the drawer outward for viewing disk 
slots (see Revolve the handle (4U56) on page 40).

4. Face the front of the drawer—and using the handle—pull the drawer outward along the drawer slide 
until it meets the first drawer stop.
The second stop is met by using your index fingers to pull the blue clips (located on both sides of the 
drawer) towards the front of the drawer. Pull the drawer outward until it meets the next drawer stop.

NOTE: Do not pull out a drawer that is fully loaded with disks to the second stop.

To close the drawer, simply slide the drawer into the enclosure along the drawer slide until it properly seats 
in the drawer bay. Take care to ensure that no loose cable wires protrude beyond the limits of the igus 
chainflex cable. Note that the drawer will lock at the second stop. To release the lock, use your index 
fingers to pull the blue clips towards the front of the drawer and slide the drawer into the enclosure. After 
closing the drawer, revolve the handle upwards such that it is flush with the drawer front panel—in stowed 
position—and tighten the two handle screws. Re-attach the bezel to the front of the enclosure.
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Figure 26 Loosen the drawer stop screw (4U56)

Figure 27 Revolve the handle (4U56)

DRAWER 0 DRIVES 0 − 27
PN: 21−00000590−00−01 rev A

DRAWER 1 DRIVES 28 − 55
PN: 21−00000590−00−02 rev A

Drawer toggle moved to right position
allows Drawer 0 to pull forward.

Bird’s eye right view (Drawer 1 hidden)
Note:

Loosen screws on target drawer

Enclosure front panel featuring
drawer access components

90°

Drawer handle

Stow pos i t ion

Pu l l  pos i t ion

Revolve handle to suit open
and close drawer actions.

Enclosure front panel (partial)
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Replacing a disk drive module
A disk drive module consists of a disk in a sled. Disk drive modules are hot-swappable, which means they 
can be replaced without halting I/O to the disk groups, or powering off the enclosure. The new disk drive 
module must be of the same type, and possess capacity equal to or greater than the one being replaced. 
Otherwise, the storage system cannot use the new disk to reconstruct the disk group. 

If one or more disks fail in a disk group and spares of the appropriate size (same or larger) and type 
(same as the failed disks) are available, the storage system automatically uses the spares to reconstruct the 
disk group. Disk group reconstruction does not require I/O to be stopped, so volumes can continue to be 
used while reconstruction is in progress.

If no spares are available, reconstruction does not start automatically. To start reconstruction manually, 
replace each failed disk and designate each replacement disk as a spare. If you have configured the 
dynamic spares feature through the CLI, reconstruction will automatically start for linear disk groups. With 
dynamic spares enabled, if a disk fails and you replace it with a compatible disk, the storage system 
rescans the bus, finds a new disk, automatically designates it a spare, and starts reconstructing the disk 
group.

For virtual storage only, reconstruction of all disk groups uses a quick-rebuild feature.

FDE considerations
The Full Disk Encryption feature available via the management interfaces requires use of self-encrypting 
drives (SED) which are also referred to as FDE-capable disk drive modules. When installing FDE-capable 
disk drive modules, follow the same procedures for installing disks that do not support FDE. The exception 
occurs when you move FDE-capable disk drive modules for one or more disk groups to a different system, 
which requires additional steps.

The procedures for using the FDE feature, such as securing the system, viewing disk FDE status, and 
clearing and importing keys are performed using the SMC, RAIDar, or CLI commands (see the 6004 
Series content within the Storage Management Guide or CLI Reference Guide for more information).

NOTE: When moving FDE-capable disk drive modules for a disk group, stop I/O to the disk group before 
removing the disk drive modules. Import the keys for the disks so that the disk content becomes available.

While replacing or installing FDE-capable disk drive modules, consider the following:

• If you are installing FDE-capable disks drive modules that do not have keys into a secure system, the 
system will automatically secure the disks after installation. Your system will associate its existing key 
with the disks, and you can transparently use the newly-secured disks.

• If the FDE-capable disk drive modules originate from another secure system, and contain that system’s 
key, the new disks will have the Secure, Locked status. The data will be unavailable until you enter the 
passphrase for the other system to import its key. Your system will then recognize the metadata of the 
disk group and incorporate it. The disks will have the status of Secure, Unlocked and their contents will 
be available:
• To view the FDE status of disks, use the SMC, RAIDar, or the show fde-state CLI command.
• To import a key and incorporate the foreign disks, use the SMC, RAIDar, or the set 

fde-import-key CLI command.

NOTE: If the FDE-capable disks contain multiple keys, you will need to perform the key importing 
process for each key to make the content associated with each key become available.

• If you do not want to retain the disks’ data, you can repurpose the disks. Repurposing disks deletes all 
disk data, including lock keys, and associates the current system’s lock key with the disks.
To repurpose disks, use the SMC, RAIDar, or the set disk CLI command.

• You need not secure your system to use FDE-capable disks. If you install all FDE-capable disks into a 
system that is not secure, they will function exactly like disks that do not support FDE. As such, the data 
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they contain will not be encrypted. If you decide later that you want to secure the system, all of the disks 
must be FDE-capable.

• If you install a disk module that does not support FDE into a secure system, the disk will have the 
Unusable status and will be unavailable for use.

• If you are re-installing your FDE-capable disk drive modules as part of the process to replace the 
chassis-and-midplane FRU, you must insert the original disks and re-enter their FDE passphrase.

Air management in disk drive slots
Air management solution inserts are used with 2U48 enclosures. The 4U56 enclosure does not require use 
of an air management device in disk drive slots.

Air management solution insert
An air management solution (AMS) insert—also known as a blank—is a plastic insert that is used in lieu of 
the four disk drive modules within a disk drive bay, or within an individual disk drive slot. Both the disk bay 
AMS (see Figure 28) and the single disk drive slot AMS (see Figure 30 on page 43) are used to maintain 
optimal air flow for proper cooling within the enclosure.

If you must remove a disk drive module, but cannot immediately replace it, you must either leave the faulty 
module in place, or arrange to replace it with an AMS.

Familiarize yourself with the disk drive module replacement procedures in this subsection before replacing 
a faulty disk with another disk drive module; replacing a faulty disk with a single drive slot AMS; or 
replacing a multiple of four disk drive modules in a given bay with a disk bay AMS.

To access disk slots in the drawer bays, you must first do the following:

• Remove the enclosure bezel (see Removing the enclosure bezel (2U) on page 25). 
• Pull the drawer outward as described in Opening and closing a 2U16 drawer on page 37.

Installing an AMS into a 2U16 drawer
Refer to Figure 28 when orienting the AMS for insertion into the target drawer. If you are installing into the 
left or middle drawer, refer to the illustrations on the left when performing this step-procedure. If you are 
installing into the right drawer, refer to the illustrations on the right when performing this step-procedure.

Figure 28 Orient the AMS for installation (2U48)

1. Squeeze the latch release flanges together—so that the locking-nib will clear the sheet metal bay 
wall—and insert the AMS into the target disk bay.

2. Verify that the AMS is firmly seated in place.
The installed AMS insert should now appear as shown in the sectioned cutaway views of the respective 
drawers in Figure 29.

Align AMS for insertion into disk bay

Right drawerLeft or middle drawer
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Figure 29 Secure the AMS into the disk bay (2U48)

If using the new single disk slot AMS insert shown in Figure 30, the insertion steps are essentially the same 
as those described for Figure 28 on page 42 and Figure 29 above; however, they pertain to a single disk 
slot rather than a disk bay (four vertically-contiguous disk slots).

Figure 30 AMS insert for a single disk slot (2U48)

IMPORTANT: Each disk bay must be populated with either a full complement of four disk drive modules, a 
disk bay AMS (shown above), or a combination of disks and single disk slot AMS inserts (See Figure 30). 
Empty disk slots are disallowed.

Removing an AMS from a 2U16 drawer
Refer to Figure 32 when removing the AMS from the target drawer. If you are extracting from the left or 
middle drawer, refer to the illustration on the left when performing the step procedure. If you are extracting 
from the right drawer, refer to the illustration on the right when performing this step-procedure.

Figure 31 Remove the AMS from the disk bay (2U48)

Right drawerLeft or middle drawer

The single disk slot AMS insert
is slated to replace the disk
bay AMS insert over time.

Remove AMS from disk bay

Right drawerLeft or middle drawer
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1. Squeeze the latch release flanges together—so that the locking-nib will clear the sheet metal bay 
wall—and extract the AMS from the target disk bay.

2. Pull the AMS insert straight out of the disk bay as show in Figure 31.

If using the new single disk slot AMS insert shown in Figure 30 on page 43, the insertion steps are 
essentially the same as those described for Figure 31 on page 43; however, they pertain to a single disk 
slot rather than a disk bay (four vertically-contiguous disk slots).

Before you begin

CAUTION: Removing a disk drive module impacts the airflow and cooling ability of the enclosure. If the 
internal temperature exceeds acceptable limits, the enclosure may overheat and automatically shut down 
or restart. To avoid potential overheating, wait 20 seconds to allow the internal disks to stop spinning, then 
insert the new disk drive module.

See the CAUTION bullets regarding “electrostatic discharge” and “anti-static protection” on page 23.

Verifying component failure
Before replacing a disk, perform the following steps to ensure that you have correctly identified the module 
requiring removal and replacement.

CAUTION: Failure to identify the correct disk drive module could result in data loss if the wrong disk is 
removed from the enclosure. 

For line-of-sight viewing of individual disk LEDs, you must remove the enclosure bezel and open the drawer 
to view its installed disks and blanks (if used). When a disk fails or a fault occurs, the disk LED illuminates 
with a 4Hz (4:1) blue blink behavior (see the AssuredSAN 6004 Series Setup Guide for a description of 
LEDs and disk drive slot numbering for your enclosure. Also see Appendix A — Drawer description for 
2U48 chassis for a summary). You can determine from visual inspection which disk in the drawer is 
experiencing a fault/failure.

Alternatively, you can observe disk component health using management interfaces to verify component 
failure or component operation (see Using management interfaces on page 75 for more information).

Removing a disk drive module (2U48)
To access disk slots in the drawer bays, you must first do the following:

• Remove the enclosure bezel (see Removing the enclosure bezel (2U) on page 25). 
• Pull the drawer outward as described in Opening and closing a 2U16 drawer on page 37.

IMPORTANT: Drawer and disk slot numbering are described pictorially on the adhesive label laminated 
to the top side of each drawer. Disk slot numbering for drawers 0 (left) and 1 (middle) begins at the front 
of the drawer and moves inward (column-by-column) along the z-axis; whereas disk slot numbering for 
drawer 2 (right) begins at the rear of the drawer and moves outward (column-by-column).

IMPORTANT: Familiarize yourself with FDE considerations on page 41 before performing this 
step-procedure.

If you are removing a disk drive module from the left drawer or middle drawer, refer to the illustrations on 
the left when performing this step-procedure. If you are removing a disk drive module from the right drawer, 
refer to the illustrations on the right when performing this step-procedure.
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IMPORTANT: Disk module removal guidelines:
• Stop I/O to the disk (see Stopping I/O on page 29).
• Remove only one disk drive module at a time: concurrent/multiple disk module removal is not allowed.
• Remove the disk module (per step procedure)—wait 30 seconds—before removing another disk.

1. Squeeze the latch release flanges together to release the locking-nib on the right side of the sled from 
the drawer cage wall, and disengage the disk drive module from its connector on the drawer PCBA 
(see illustration for appropriate drawer in Figure 32 on page 45).

Figure 32 Disengaging a disk drive module (2U48)

2. Wait 20 seconds for the internal disks to stop spinning. 
3. Firmly grasp the front of the plastic sled, and pull the disk drive module straight out of the chassis, 

taking care not to drop the module (see illustration for appropriate drawer in Figure 33).

Figure 33 Removing a disk drive module (2U48)

Removing a disk drive module (4U56)
To access disk slots in the drawer bays, you must first do the following:

• Remove the enclosure bezel (see narrative instructions following Figure 15 on page 26). 
• Pull the drawer outward as described in Opening and closing a 4U28 drawer on page 39.

IMPORTANT: Drawer and disk slot numbering are described pictorially on the adhesive label laminated 
to the exterior wall of each drawer. Disk slot numbering for drawers 0 (left) and 1 (right) begins at the front 
of the drawer and moves inward (row-by-row) along the x-axis.

IMPORTANT: Familiarize yourself with FDE considerations on page 41 before performing this 
step-procedure.

Disengage and extract the SFF 2.5" disk drive module

Right drawerLeft or middle drawer

Remove the SFF 2.5" disk drive module

Right drawerLeft or middle drawer
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IMPORTANT: Disk module removal guidelines:
• Stop I/O to the disk (see Stopping I/O on page 29).
• Remove only one disk drive module at a time: concurrent/multiple disk module removal is not allowed.
• Remove the disk module (per step procedure)—wait 30 seconds—before removing another disk.

1. Using your index finger, slide the release latch—located in the upper pocket on the face of the disk 
drive module—forward to disengage the disk drive module (see detail inset view in Figure 34).
Moving the latch forward will provide a clicking sound and cause the spring to move its position inside 
the drawer cage, partially ejecting the disk from its installed position within the disk drive slot.

Figure 34 Remove a disk from a drawer slot (4U56)

2. Wait 20 seconds for the internal disks to stop spinning.
3. Once the disk drive module partially ejects from the slot, grasp the module firmly, and carefully pull it 

straight out of the drawer slot. Take care not to drop the module.

Installing a disk drive module (2U48)
To access disk slots in the drawer bays, you must first do the following:

• Remove the enclosure bezel (see Removing the enclosure bezel (2U) on page 25). 
• Pull the drawer outward as described in Opening and closing a 2U16 drawer on page 37.

IMPORTANT: Familiarize yourself with FDE considerations on page 41 before performing this 
step-procedure to mitigate the potential for unusable installed disks.

IMPORTANT: Disk module installation guidelines:
• Install only one disk drive module at a time: concurrent/multiple disk module insertions are not allowed.
• Install the disk module (per step procedure)—wait 45 seconds—before installing another disk module.

The enclosure uses an SFF sledded disk positioned to lay on its side—with the disk PCBA facing up—for 
insertion into the disk slot within the drawer. Each disk is mated to a connector on the drawer PCBA. 

If you are installing a disk drive module in the left drawer or middle drawer, refer to illustrations on the left 
when performing the step-procedure. If you are installing a disk drive module in the right drawer, refer to 
illustrations on the right when performing this step-procedure.

Release latch
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1. While supporting the bottom of the disk drive module with one hand (disk PCBA should be facing up 
and latch release flanges should be facing out)—align the disk drive module for insertion into the target 
disk slot (see illustration for appropriate drawer in Figure 35 on page 47).

2. Using your other hand, squeeze the latch release flanges together—so that the locking-nib will clear the 
sheet metal bay wall—and insert the disk drive module into the target slot (see illustration for 
appropriate drawer in Figure 35 on page 47).

Figure 35 Aligning the disk drive module (2U48)

3. Gently push the disk drive module into the slot until it latches in place.
The installed disk drive module should now appear as shown (see illustration for appropriate drawer in 
Figure 36). Wait 45 seconds before installing another disk.

Figure 36 Installing a disk drive module (2U48)

Installing a disk drive module (4U56)
To access disk slots in the drawer bays, you must first do the following:

• Remove the enclosure bezel (see Removing the enclosure bezel (4U) on page 26). 
• Pull the drawer outward as described in Opening and closing a 4U28 drawer on page 39.

IMPORTANT: Familiarize yourself with FDE considerations on page 41 before performing this 
step-procedure to mitigate the potential for unusable installed disks.

IMPORTANT: Disk module installation guidelines:
• Install only one disk drive module at a time: concurrent/multiple disk module insertions are not allowed.
• Install the disk module (per step procedure)—wait 45 seconds—before installing another disk module.

Align the SFF 2.5" disk drive module

Right drawerLeft or middle drawer

Right drawerLeft or middle drawer

Secure the SFF 2.5" disk drive module into the disk slot
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IMPORTANT: If you are completely filling a drawer with disk modules, populate from back row to front 
row, while installing disks into the slots. Provide adequate support for the weight of the extended drawer as 
you install the disks.
If you are installing disk modules to partially fill a drawer, you must install a minimum of 14 disk modules, 
and they must be placed in contiguous slots closest to the front of the drawer. 

The enclosure uses an LFF sledded disk positioned to stand on end, for insertion into the disk slot within the 
drawer. Each disk is mated to a connector on the drawer PCBA.

1. With the disk module standing on end—and the LEDs oriented to the left—insert the disk module into 
the vertically-aligned disk slot. Notches on the inside of the drawer will help guide the disk to the 
correct position and seat the disk into the connector on the drawer PCBA.

2. Verify that you have inserted the disk module into the slot as far as it will go. A spring in the drawer slot 
will provide a resistive force when mating the drive to the connector. This will ensure that the module is 
firmly seated in the drawer PCBA.

.

Figure 37 Install a disk into a drawer slot (4U56)

IMPORTANT: If you install an empty disk and intend to use it as a spare, the disk must be enabled as a 
spare in order for this procedure to be complete. Spares can be managed using the SMC, RAIDar, or the 
CLI.

Completing the disk module installation
If using the SMC, execute steps 3—5 to complete this procedure. If using RAIDar, execute steps 6 and 7 to 
complete this procedure. If using the CLI, execute steps 8 and 9 to complete this procedure.

NOTE: Allow at least 30 seconds to elapse when jointly completing the “Removing a disk drive module” 
and “Installing a disk drive module” procedures.

Using the SMC (v3):

3. Sign in to the SMC (use default user manage and password !manage, or the appropriate username 
and password if they have been changed).

4. Click the System topic. The System panel opens.
5. Click the Table tab to determine whether the health of the new disk is OK. If the health is OK, then the 

disk drive module installation process is complete. If the health is not OK, then hover over the disk to 
display details about it, such as Status and Health Recommendations.
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Using RAIDar (v2):

6. Sign in to RAIDar (use default user manage and password !manage, or the appropriate username and 
password if they have been changed).

7. View the System Overview panel to determine whether the health of the new disk is OK. If the health is 
OK, then the disk drive module installation process is complete. If the health is not OK, then in the 
Configuration View panel, select the enclosure that the new disk is in to display the Enclosure Overview 
panel, and select the disk to view details about it, such as Status and Health Recommendations.

Using the CLI:

You can set a CLI preference to use v3 commands to manage virtual storage or to use v2 commands to 
manage linear storage. 
See the TIP bullets regarding CLI “default management mode” and “current management mode” page 28.

8. Log in to the CLI (use default user manage and password !manage, or the appropriate username and 
password if they have been changed).

9. To view information about disks, run the following command:
show disks <disk-ID>

Disks are specified by enclosure ID and slot number. Enclosure IDs increment from 0. Disk IDs increment 
from 0 in each enclosure (e.g., show disks 0.7). Entering the command shown above will display 
the disk health for the disk residing in slot number 7 of enclosure number 0 (i.e., the controller 
enclosure). If health is not OK, the command output will also display recommended actions.

Determine if a disk is missing
You can determine whether a disk is missing by using management interfaces.

Using the SMC or RAIDar
To determine whether a disk is missing by using the SMC (v3):

1. Sign-in to the SMC using default user manage and password !manage.
If the default user or password—or both—have been changed for security reasons, enter the secure 
login credentials instead of the system defaults shown above.

2. Click the System topic. The System panel opens.
• Select the Front tab to display a pictorial representation of disks within slots, and hover over 

individual disks to view the metadata such as location, usage, tier, type, and size.
• You can hover over enclosure ears to see metadata for specific enclosures in the system.
• Select the Table tab to display a tabular view of information about physical components in the 

system.
3. Using the Front and Table views, look for gaps in the disk location sequence to determine if a disk is 

missing.

To determine whether a disk is missing by using RAIDar (v2):

1. Sign-in to RAIDar using default user manage and password !manage.
If the default user or password—or both—have been changed for security reasons, enter the secure 
login credentials instead of the system defaults shown above.

2. In the Configuration View panel, right-click the appropriate enclosure under Physical.
• Select the Front Graphical tab to display a pictorial representation of disks within slots, and the 

supporting enclosure table showing properties and values.
• Select the Front Tabular tab to display the Enclosure’s Front View data table and supporting 

enclosure table showing properties and values.
3. Using the graphical and tabular views, look for gaps in the disk location sequence to determine if a 

disk is missing.
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Using the CLI
You can set a CLI preference to use v3 commands to manage virtual storage or to use v2 commands to 
manage linear storage. 
See the TIP bullets regarding CLI “default management mode” and “current management mode” page 28.

1. Log-in to the command-line interface (CLI) using default user manage and password !manage.
If the default user or password—or both—have been changed for security reasons, enter the secure 
login credentials instead of the system defaults shown above.

2. To determine location of a missing or faulty drive, run the following command:
show disks

The command outputs a listing of detected disks’ properties by location. Review the information, and 
look for gaps in the disk location sequence to determine whether any disks are missing.

Verifying component operation
Verify that the Power/Activity LED—located on the front face of the disk drive escutcheon—is illuminated 
green.

• The disk module LED is shown in Figure 35 on page 47 or Figure 37 on page 48.
• The disk module LED behavior is described in Figure 63 on page 79 or Figure 67 on page 83.

TIP: See the AssuredSAN 6004 Series Setup Guide for descriptions of the disk drive LEDs and other front 
panel LEDs pertaining to 2U48 and 4U56 controller enclosures.

Also see Using management interfaces on page 75 as an alternative to physically observing LEDs to verify 
component operation.

Replacing a power supply module
This section provides procedures for replacing a failed AC or DC power supply module, also referred to as 
a power supply unit (PSU). Illustrations in power supply module replacement procedures show rear panel 
views of the enclosure, and PSUs are properly aligned for insertion into the rear panel of the enclosure.

A single PSU is sufficient to maintain operation of the enclosure. You need not halt operations and 
completely power-off the enclosure when replacing only one PSU; however, a complete orderly shutdown is 
required if replacing both power supply units. 

CAUTION: Power supply FRU replacement activities can cause enclosure cables to disconnect and disks 
to go offline. Be careful with cabling connections during FRU replacement.

If immediate replacement is necessary during I/O, ensure that all cables are securely fastened, and 
proceed with caution as you replace the power supply FRU within the controller enclosure. Be very careful 
if moving a cabled/operational enclosure during the FRU replacement process.

TIP: See Table 7 on page 51 for additional information about power supply faults and recommended 
actions.

Before you begin

CAUTION: Removing a power supply unit significantly disrupts the enclosure’s airflow. Do not remove the 
PSU until you have received the replacement module.
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See the CAUTION bullets regarding “electrostatic discharge” and “anti-static protection” on page 23.

Verifying component failure
You can observe power supply component health (PSUs, fans) using LEDs, management interfaces, or a 
combination thereof to verify component failure or component operation (see Using management 
interfaces on page 75 for more information).

When either a fan or power supply component fails, the SMC or RAIDar provide notification; faults are 
recorded in the event log; and the PSU’s status LED color changes to amber to indicate a fault condition.

Table 7 describes menu navigation using the SMC (v3) or RAIDar (v2). The shorthand v3 and v2 prefixes 
are used to distinguish between the GUI product versions supported by 6004 Series enclosures.

Table 7 also references a CLI command. You can set a CLI preference to use v3 commands to manage 
virtual storage or to use v2 commands to manage linear storage. See the TIP bullets regarding CLI “default 
management mode” and “current management mode” page 28.

Alternatively, you can observe power supply component health (PSUs, fans) using management interfaces 
to verify component failure or component operation (see Using management interfaces on page 75 for 
more information)

Table 7 Power supply faults and recommended actions

Problem Recommended action

Power supply fan warning or failure, or power supply 
warning or failure
Event code 551 or 168

• v3: Verify that all fans are working using the SMC.
Click the System tab within the topics pane and from 
the System topic, select the Rear tab. Hover over 
each power supply module to view health attributes.
You can also select the Table tab and view health 
status for power supply modules and other 
components in tabular form.

• v2: Verify that all fans are working using RAIDar.
In the Configuration View, expand Physical, 
right-click the enclosure and select View > Overview. 
Select either Rear Graphical or Rear Tabular to view 
health attributes.

• Optionally, you can verify that all fans are working 
using the CLI.
The show fans command will output health status 
for fans in the specified enclosure.

• Ensure that the power supply modules are properly 
seated and secured within their slots.

• Ensure that no slots are left open for more than two 
minutes. If you must replace the FRU, leave the old 
module in place until the replacement arrives, to 
maintain optimal airflow and avoid overheating.

Power supply module failure status, or voltage event 
notification
Event code 551 or 168

• Verify that the power supply module is powered on. 
If your power supply module has a power switch, 
verify that it is switched on.

• Verify that the power cables are securely attached to 
the power supply module and the appropriate power 
source.

• Replace the FRU if necessary.

AC Power Good LED is off Same as above.

Voltage/Fan Fault/Service Required LED is illuminated Replace the power supply module FRU.
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Power supply units
6004 Series enclosures feature two redundant power supplies of the same type. Except for the 2U48 
chassis—which supports AC only—enclosures can be equipped with two AC PSUs or two DC PSUs. Each 
DC power supply features a power switch. AC PSUs provided with the 2U48 and 4U56 chassis also 
feature a power switch. Some AC power supplies used with compatible storage enclosures have a power 
switch, whereas others do not. This characteristic varies by model type and vintage. 

• Figure 37 shows PSU alignment with the rear panel of a 2U enclosure.
• Figure 38 shows PSU alignment with the rear panel of a 4U enclosure.

IMPORTANT: Many AC power supply units do not have power switches. These PSUs power on when 
connected to a power source, and power off when disconnected.

Power cycling procedures vary according to the type of power supply module included with the enclosure. 
Power cycling procedures for the 6004 Series enclosures are described in this section.

AC PSUs (2U48)
The AC power supply—equipped with a power switch—is shown below as it appears when facing the rear 
panel of the enclosure. For a midplane-facing view of the PSU, see Figure 1 on page 14.

Figure 38 AC PSU with power switch (2U48)

Powering off the PSU
1. Stop all I/O from hosts to the enclosure (see Stopping I/O on page 29).

TIP: This step is not required for hot-swapping; however, it is required when replacing both PSUs.

2. Use management software to shut down any other system components necessary.

TIP: This step is not required for hot-swapping; however, it is required when replacing both PSUs.

3. Turn off the power switch on the PSU being replaced and on the replacement PSU.

Disconnecting an AC power cord
1. Verify that the power switch on the AC PSU being replaced is in the Off position.
2. Disconnect the power cord’s male plug from the power source.
3. Disconnect the power cord’s female plug from the power cord connector on the PSU.

NOTE: See  on page 56 for illustrations showing AC power cord connection/disconnection.

Power
switch

Power
cord 
connect
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AC and DC PSUs with power switch (4U56)
The AC and DC power supply are shown below as they appear when facing the rear panel of the 
enclosure. For a midplane-facing view of the PSU, see Figure 8 on page 19.

Figure 39 AC and DC PSU (4U56)

Powering off the PSU
1. Stop all I/O from hosts to the enclosure (see Stopping I/O on page 29).

TIP: This step is not required for hot-swapping; however, it is required when replacing both PSUs.

2. Use management software to shut down any other system components necessary.

TIP: This step is not required for hot-swapping; however, it is required when replacing both PSUs.

3. Turn off the power switch located below the PSU on the chassis, as shown in Figure 39.

CAUTION: When the PSU is in the Standby position, there is still power flowing through the unit. Please 
see the warning labels located on the PSU’s handle (see Figure 42 on page 55) for more information on 
power supply requirements and safety requirements.

Disconnecting an AC power cord
1. Verify that the power switch on the AC PSU being replaced is in the Standby position.
2. Disconnect the power cord’s male plug from the power source.
3. Disconnect the power cord’s female plug from the power cord connector on the PSU.

NOTE: See Connecting a power cable on page 57 for illustrations showing AC power cord 
connection/disconnection.

Disconnecting a DC power cable
1. Verify that the power switch on the DC PSU being replaced is in the Standby position.

Power supply switch (chassis-mounted)

AC power connect DC power

AC model DC model

connect



54 Procedures

2. Loosen the cable-locking screws that attach each connector to its power supply, and carefully 
disconnect the lugs on each cable wire component of the DC power cable from the DC power source

Figure 40 DC power cable featuring 2-circuit header and lug connectors (4U)

3. Loosen the cable-locking screws attaching the connector to the PSU, and disconnect the power cable 
from the PSU.

Removing a power supply unit (2U48)
1. If replacing a single power supply module via hot-swap, proceed to step 3.
2. If replacing both power supply modules, verify that the enclosure is powered off.

Verify that the power switch is set to the Off position.
3. Verify that the power cord is disconnected.
4. Turn the thumbscrew at the top of the latch counterclockwise to loosen and disengage it from the 

module; however, do not remove the thumbscrew from the latch.
5. Rotate the latch downward by approximately 45, supplying sufficient leverage to disconnect the 

module from the internal connector.
See Figure 41 on page 54.

Figure 41 Removing a power supply unit (2U48)

6. Use the latch to pull the module straight out of the chassis slot, taking care to support the base of the 
PSU—with both hands—as you remove it from the enclosure.

7. If replacing two power supply modules, repeat step 3 through step 6.

CAUTION: Do not lift the module by its latch; doing so could damage the latch. Using both hands, lift 
and carry the module using its metal casing.

Connector (front view) Power cable (right side view with wire breaks)

+L

-L

+L

-L

+L

-L

Connector screw (typical 2 places)

Ring/lug connector (typical 2 places)

(+)

(-)

Thumbscrew

Revolved latch

Power supply unit (PSU)

Power supply unit

Controller or expansion enclosure

(installed position)

(AC model with power switch)

(cover plates are shown in lieu of IOMs)
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Removing a power supply unit (4U56)
1. If replacing a single power supply module via hot-swap, proceed to step 3.
2. If replacing both power supply modules, verify that the enclosure is powered off.

Verify that the power switch is set to the Standby position.
3. Verify that the power cords are both disconnected.
4. Using your index finger, move the red latch up to disconnect the module from the internal connector.

See Figure 42 below.

Figure 42 Removing a power supply unit (4U56)

5. Pull the module straight out of the chassis slot, taking care to support the base of the PSU—with both 
hands—as you remove it from the enclosure.

6. If replacing two power supply modules, repeat step 3 through step 5.

CAUTION: Do not lift the module by its plastic protective cover; doing so could damage the cover. Using 
both hands, lift and carry the module using its metal casing.

Installing a power supply unit (2U48)

Figure 43 Orienting a power supply unit (2U48)

To install a power supply module, perform the following steps:

Power
switch

Power
cord 
connect
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1. Orient the PSU with the AC power cable connector toward the right as shown above.
2. With the latch in the open position, ensure that the power supply module is level, and slide it into the 

appropriate power supply slot as far as it will go.
3. Rotate the PSU latch upward until it is flush against the PSU face, ensuring that the connector on the PSU 

engages the connector inside the chassis.
4. Turn the thumbscrew located at the top of the power supply latch clockwise, until it is finger-tight, to 

secure the latch to the power supply unit within the enclosure.
5. If replacing two power supply modules, repeat step 1 through step 4.

Installing a power supply unit (4U56)

Figure 44 Orienting a power supply unit (4U56)

To install a power supply module, perform the following steps:

1. Orient the PSU with the power cable connector on the bottom as shown above.
2. With the handle in the open position, ensure that the power supply module is level, and slide it into the 

appropriate power supply slot as far as it will go.
3. Using your index finger, move the red button up, ensuring that the connector on the PSU engages the 

connector inside the chassis.
4. If replacing two power supply modules, repeat step 1 through step 3.

Figure 45 Installing a power supply unit (4U56)

Power supply switch (chassis-mounted)

AC power connect DC power
connect

AC model DC model
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Connecting a power cable
This section addresses power cable connection for enclosures configured with AC and DC power supply 
modules.

Connecting an AC power cord (2U)
The diagram at right shows power cord connection 
between the PSU and rack power source.

1. Install the power cord:
a. Connect the female plug to the AC PSU cord inlet.
b. Connect the male plug to the rack power source.
Verify connection of the primary power cord(s) from the 
rack to separate external power sources.

2. Power-on the newly-installed PSU:
a. Press the power switch to the On position.
b. Wait several seconds for the disks to spin up.

3. If replacing two power supply modules, repeat step 1 
and step 2.

Connecting an AC power cord (4U)

Figure 46 Connecting an AC power cord (4U56)

Obtain two suitable power cords: one for each AC power supply that will connect to a separate power 
source. See the figure at right when performing the following steps:

1. Verify that the enclosure’s power switches are in the Standby position.
2. Identify the power cord connector on the PSU, and locate the target power source.
3. Using the AC power cords provided, plug one end of the cord into the power cord connector on the 

PSU. Plug the other end of the power cord into the rack power source.
4. Verify connection of primary power cables from the rack to separate external power sources.

Connecting a DC power cable (4U)
1. Locate the appropriate DC power cables.
2. Verify that the enclosure’s power switches are in the Standby position.
3. Connect the DC power to each DC power supply using the 2-circuit header connector.
4. Tighten the screws at the base of the connector—left and right sides—applying a torque between 1.7 

N-m (15 in-lb) and 2.3 N-m (20 in-lb), to securely attach the cable to the DC power supply module.
5. To complete the DC connection, secure the other end of each cable wire component of the DC power 

cable to the target DC power source.
Check the two individual DC cable wire labels before connecting each cable wire lug to its power 
source. One wire is labeled positive (+L) and the other is labeled negative (-L). The 6004 Series 

Power supply
module

Rack power
source

CACHE

LINK

DIRTY

LINK

ACT

CLI
CLI

SERVICE−2

SERVICE−1

PORT 0 PORT 1

PORT 2 PORT 3

6Gb/s

Power supply Rear panel

Rack

WARNING: NOT A LIFT POINT

cord
AC power
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enclosure is grounded independently of this DC cable. The chassis ground wire is connected from a 
dual lug on its mounting rail to the rack in which it is mounted.

CAUTION: Connecting to a DC power source outside the designated -48VDC nominal range 
(-36VDC to -72 VDC) may damage the enclosure.

Verifying component operation (2U)
Examine a 2U48 PSU module status as indicated in the table below.

LEDs for a 2U48 PSU are located in the top right corner of the module face, as shown in Figure 43 on 
page 55.

The top LED corresponds to LED number (1) above, and the bottom LED corresponds to number (2) above. 
If the Voltage/Fan Fault/Service Required LED is illuminated amber, the PSU module has not gone online, 
and likely failed its self-test. Remove and reinstall the PSU module. In addition to viewing the PSU LEDs, 
verify that the cooling fans are spinning. Also see Using management interfaces on page 75 as an 
alternative to physically observing LEDs to verify component operation.

Verifying component operation (4U)
Examine a 4U56 PSU module status as indicated in the table below.

Table 8 Power supply unit LED descriptions (2U)

LED No./Description Color State Definition

1 — Input Source Power Good Green On Power is on and input voltage is normal.

Off Power is off, or input voltage is below the minimum 
threshold.

2 — Voltage/Fan Fault/
Service Required

Amber On Output voltage is out of range, or a fan is operating 
below the minimum required RPM.

Off Output voltage is normal.

1
2
3

Power supply switch (chassis-mounted)

1
2
3

AC power connect DC power

AC model DC model
Table 9 Power supply unit LED descriptions (4U)

LED No./Description Color State Definition

1 — AC Input Source Green On Power is on and input voltage is normal.

Off No AC input to PSU.

2 — Voltage/Fan Fault/Service 
Required

Amber On
Blinking

Output voltage is out of range, or a fan is operating 
below the minimum required RPM.

Off Fault not detected.
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LEDs for a 4U56 PSU are located in the bottom left corner of the module face, as shown above.

If the Voltage/Fan Fault/Service Required LED is illuminated amber, the PSU module has not gone online, 
and likely failed its self-test. Remove and reinstall the PSU module. In addition to viewing the PSU LEDs, 
verify that the cooling fans are spinning. Also see Using management interfaces on page 75 as an 
alternative to physically observing LEDs to verify component operation.

Replacing a fan control module
This section provides procedures for replacing a failed fan control module (FCM). The FCM FRU is unique 
to 4U56 enclosures. Illustrations in fan control module replacement procedures show rear panel views of 
the enclosure, and FCMs are properly aligned for insertion into the rear panel of the enclosure.

A single FCM is sufficient to maintain operation of the enclosure. You need not halt operations and 
completely power-off the enclosure when replacing only one FCM; however, a complete orderly shutdown 
is required if replacing both fan control modules. 

TIP: See Table 10 for additional information about fan module faults and recommended actions.

Before you begin

CAUTION: Removing a fan control module significantly disrupts the enclosure’s airflow. Do not remove 
the FCM until you have received the replacement module.

See the CAUTION bullets regarding “electrostatic discharge” and “anti-static protection” on page 23.

Verifying component failure
You can observe fan module component health (PSUs, fans) using LEDs, management interfaces, or a 
combination thereof to verify component failure or component operation (see Using management 
interfaces on page 75 for more information).

When either a fan or power supply component fails, the SMC or RAIDar provide notification; faults are 
recorded in the event log; and the FCM’s status LED color changes to amber to indicate a fault condition.

Table 10 describes menu navigation using the SMC (v3) or RAIDar (v2). The shorthand v3 and v2 prefixes 
are used to distinguish between the GUI product versions supported by 6004 Series enclosures.

3 — DC Power Green On Main output power on.

Off Power is off; main output is off; or a fault is detected.

Table 9 Power supply unit LED descriptions (4U) (continued)

LED No./Description Color State Definition
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Table 10 also references a CLI command. You can set a CLI preference to use v3 commands to manage 
virtual storage or to use v2 commands to manage linear storage. See the TIP bullets regarding CLI “default 
management mode” and “current management mode” page 28.

Table 10 Fan control module faults and recommended actions (4U56)

Problem Recommended action

Power supply fan warning or failure, or fan module 
warning or failure
Event code 552 or 558 (4U56)

• v3: Verify that all fans are working using the SMC.
Click the System tab within the topics pane and from 
the System topic, select the Rear tab. Hover over 
each fan control module to view health attributes.
You can also select the Table tab and view health 
status for fan control modules and other components 
in tabular form.

• v2: Verify that all fans are working using RAIDar.
In the Configuration View, expand Physical, 
right-click the enclosure and select View > Overview. 
Select either Rear Graphical or Rear Tabular to view 
health attributes.

• Optionally, you can verify that all fans are working 
using the CLI.
The show fans command will output health status 
for fans in the specified enclosure.

• Ensure that the power supply modules are properly 
seated and secured within their slots.

• Ensure that the fan control modules are properly 
seated and secured within their slots.

• Ensure that no slots are left open for more than two 
minutes. If you must replace the FRU, leave the old 
module in place until the replacement arrives, to 
maintain optimal airflow and avoid overheating.

AC Power Good LED is off Same as above.

Voltage/Fan Fault/Service Required LED is illuminated Replace the power supply module FRU.
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Removing a fan control module
1. If replacing a single fan control module via hot-swap, proceed to step 3.
2. If replacing both fan control modules, verify that the enclosure is powered off.
3. Verify that the power cord is disconnected.
4. Using your index finger, move the latch (located on the right side of the handle) to the left.

See Figure 47 on page 61.

Figure 47 Removing a fan control module (4U56)

5. While holding the handle with the latch pinched, pull the module straight out of the chassis slot, taking 
care to support the base of the FCM—with both hands—as you remove it from the enclosure.

6. If replacing two fan control modules, repeat step 3 through step 5.

CAUTION: The fan may continue to rotate after removing the FCM.
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Installing a fan control module
To install a fan control module, perform the following steps:

1. Orient the FCM with the power connector (located on the back of the FCM) on the top right. 
There is a stop pin to prevent insertion of the FCM in the wrong orientation.

2. With the latch in the open position, ensure that the fan control module is level, and slide it into the 
appropriate fan control slot as far as it will go. 
When the FCM has locked into position, you will hear a click from the latch.

3. If replacing two fan control modules, repeat step 1 and step 2.

Figure 48 Installing a fan control module (4U56)
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Verifying component operation
Examine FCM module status as indicated in the table below.

Figure 49 Fan control module LED descriptions (4U56)

Replacing ear components
Before you begin

CAUTION: Verify that you have the proper FRU kit (left or right) for the ear components being replaced.

See the CAUTION bullets regarding “electrostatic discharge” and “anti-static protection” on page 23.

Enclosure ear kit FRUs are available for the left and right ears of the chassis front panel. The following 
replacement procedure applies to ear kits provided with the 4U56 enclosure models. Refer to the following 
illustrations when removing or installing ear kit components. Illustrations in ear kit replacement procedures 
show front panel views, and ear kit components are properly aligned for attachment to the ears on the front 
panel of the enclosure.

LED No./Description Color State Definition

1 — FRU OK Green On Power is on with at least one fan operating normally.

Off Both fans are off; the system is powered off.

2 — Fault/Service Required Amber On Fault detected; event has been acknowledged but the 
problem needs attention.

Off No fault condition exists.

3 — Unit locator White On FRU is identified.

Off Normal operation.

1
2
3
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2U48 chassis ears
Figure 50 shows the left ear of a 2U48 model with the LED circuit board exploded from its installed 
position on the ear flange. The enclosure bezel is removed to reveal the left ear flange and the left drawer 
in closed position. See Attaching and removing the enclosure bezel on page 25 (Figure 15) for bezel 
attachment and removal details.

Figure 50 Replacing left ear components (2U48)

Figure 51 shows the right ear of a 2U48 model. The enclosure bezel is removed to reveal the right ear 
flange and the right drawer in closed position. The LED circuit board is shown exploded from its installed 
position—and aligned with the light pipe sub-assembly—which is integral to the enclosure bezel.

Figure 51 Replacing right ear components (2U48)

The enclosure bezel attaches to four ball studs on the front of the enclosure: each chassis ear flange hosts 
two ball studs. Relative to both left and right ear kits, see Removing ear components on page 66 and 
Installing ear kit components on page 66.

Left ear with bezel removed
(left drawer shown)

OK

Right ear explosion
(right drawer shown)

Unit Locator
Fault/Service Required
FRU OK
Temperature Fault

LED circuit
board

LED light pipes subassembly
(included in bezel)
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4U56 chassis ears
Figure 52 shows the left ear of a 4U56 models with the LED circuit board exploded from its installed 
position on the ear flange. The enclosure bezel is removed to reveal the left ear flange and the left drawer 
in closed position. See Attaching and removing the enclosure bezel on page 25 (Figure 15) for bezel 
attachment and removal details.

Figure 52 Replacing left ear components (4U56)

Figure 53 shows the right ear of 6004 model. The enclosure bezel is removed to reveal the right ear flange 
and the right drawer in closed position. The LED circuit board is shown exploded from its installed 
position—and aligned with the light pipe sub-assembly—which is integral to the enclosure bezel.

Figure 53 Replacing right ear components (4U56)

The enclosure bezel attaches to four ball studs on the front of the enclosure: each chassis ear flange hosts 
two ball studs. Relative to both left and right ear kits, see Removing ear components on page 66 and 
Installing ear kit components on page 66.

TIP: If your 4U56 enclosure is equipped with a bezel that employs an optional air filter, refer to the 
Enclosure Bezel Kit Installation document—included in your product shipkit—for instructions on servicing 
the air filter.

Left ear with bezel removed

AssuredSAN

OK

Right ear explosion

Unit Locator
Fault/Service Required

FRU OK
Temperature Fault

LED light pipes subassembly
(included in bezel)
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Removing ear components
See the appropriate ear illustrations for your product model when removing the bezel and ear components:

• 2U48 chassis: Figure 50 on page 64 (left ear) and Figure 51 on page 64 (right ear)
• 4U56 chassis: Figure 52 on page 65 (left ear) and Figure 53 on page 65 (right ear)

1. Stop all I/O from hosts to the system.
2. Use management software to shut down any other components necessary.
3. Power off the enclosure. Take care to remove both power cords.
4. Remove the enclosure bezel:

• See Figure 14 on page 25 and supporting narrative for 2U48 enclosure bezel removal.
• See Figure 15 on page 26 and supporting narrative for 4U56 enclosure bezel removal.

5. On the target ear, loosen the two screws securing the LED circuit board to the threaded mounting 
sleeves protruding from the ear flange. Use a No.2 Phillips screw driver.
Remove the screws and retain them for use when installing the new LED circuit board.

6. Remove the ESD cage protecting the LED circuit board, and retain it for reinstallation (applies to left ear 
kit replacement only: see Figure 50 or Figure 52 on page 65).

7. Disconnect the flexible ribbon cable from the back of the LED circuit board.
a. Pull gently on the LED circuit board to stretch the ribbon cable attached to the back of the board.
b. Reach behind the LED circuit board, and slightly pull outward on the locking mechanism of the 

connector to release the flexible ribbon cable from the circuit board.
8. Remove the LED circuit board, and label it as damaged or defective to prevent its reuse.

• 2U48 chassis circuit board and LEDs: see Figure 50 on page 64 (left ear) and Figure 51 on 
page 64 (right ear)

• 4U56 chassis circuit board and LEDs: see Figure 52 on page 65 (left ear) and Figure 53 on 
page 65 (right ear)

Installing ear kit components
See the appropriate ear illustrations for your product when installing ear components:

• 2U48 chassis: see Figure 50 on page 64 (left ear) and Figure 51 on page 64 (right ear)
• 4U56 chassis: see Figure 52 on page 65 (left ear) and Figure 53 on page 65 (right ear)

1. Locate the replacement LED circuit board for the target ear.
2. Verify that the enclosure is powered off. Remove both power cords (4U56 only).
3. Install the LED circuit board for the target ear:

a. Properly orient the replacement LED circuit board, and align it for installation onto the ear flange as 
shown in the pertinent illustration (see bullet list above).

b. Release the locking mechanism on the ribbon cable connector, located on the back of the LED 
circuit board, by pulling out on the locking mechanism.

c. While holding the flexible ribbon cable steady, insert it into the connector on the back of the LED 
circuit board, and push in on the locking mechanism to secure the cable connection.

d. Locate the ESD cage and align its through-holes with those on the LED circuit board (applies to left 
ear kit replacement only: see Figure 50 or Figure 52 on page 65).

e. Locate the LED circuit board fastener screws that you previously removed, and insert a screw through 
each of the board’s two mounting holes, and into the threaded hole of the sleeve on the ear flange.

f. Take care to ensure that the screw threads correctly mesh with the threads in the hole—in order to 
avoid cross-threading or stripping—and hand tighten them. If a calibrated torque driver is 
available, torque each screw to 3 in./lbs.

g. Verify that the LED circuit board is securely installed and the flexible ribbon cable is fully-seated into 
the connector, and locked in place.

4. Gently slip the enclosure bezel cover onto the push-fit mounting ball studs, taking care to guide the LED 
indicators through the bezel’s ear covers. 

5. Power on the enclosure.
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TIP: See the AssuredSAN 6004 Series Setup Guide for descriptions of front panel LEDs.

Verifying component operation
Enclosure status LEDs are located on the front of the controller enclosure. During normal operation, the FRU 
OK and Temperature Fault LEDs are green, and the other status LEDs located on the right ear are off.

Transceivers used in CNC ports
AssuredSAN 6844/6854 models use Converged Network Controller (CNC) technology, allowing you to 
select the desired host interface protocol from available Fibre Channel (FC) or Internet SCSI (iSCSI) host 
interface protocols supported by the system. You can use the CLI to set all controller module CNC ports to 
use one of these host interface protocols: 16 Gbit/s FC; 8 Gbit/s FC; 10GbE iSCSI; or 1 Gbit/s iSCSI.

Alternatively, you can use the CLI to set CNC ports to support a combination of host interface protocols. 
When configuring a combination of host interface protocols, host ports 0 and 1 must be set to FC (either 
both 16 Gbit/s or both 8 Gbit/s), and host ports 2 and 3 must be set to iSCSI (either both 10GbE or both 
1 Gbit/s), provided the CNC ports use the qualified SFP connectors and cables required for supporting 
the selected host interface protocol. CNC ports can be used for host connection or remote replication, 
provided the optional AssuredRemote™ feature is licensed.

IMPORTANT: To change the host port mode for CNC ports, follow the “Change the host port mode” 
instructions provided in the AssuredSAN 6004 Series Setup Guide.

Replacing a Fibre Channel transceiver
This section provides steps for replacing a small form-factor pluggable (SFP transceiver) connector used in a 
Fibre Channel controller module host port. An example SFP connector is shown below. It is pictorially 
oriented to align for insertion into the CNC port, such that the connector is flush with the IOM face plate on 
the enclosure rear panel.

Figure 54 Sample SFP connector

NOTE: See the “6844/6854 CNC controller module — rear panel components” topic within the Setup 
Guide for an illustration showing an FC SFP installed within the IOM.

Before you begin

CAUTION: Mishandling fibre-optic cables can degrade performance. Do not twist, fold, pinch, or step on 
fibre-optic cables. Do not bend them tighter than a 2-inch radius.
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See the CAUTION bullets regarding “electrostatic discharge” and “anti-static protection” on page 23.

CAUTION: To prevent potential loss of access to data, be sure to identify the correct cable and SFP 
connector for subsequent removal.

Verifying component failure
Transceivers are part of a data path that includes multiple components, such as the transceiver, a cable, 
another SFP, and an HBA (host bus adapter). A reported fault can be caused by any component in the 
data path. To identify the location of the fault, check the Link Status/Link Activity LED on the controller 
module face plate, and check the link status and link activity LEDs on the server. Also, check the cable for 
kinks, crimping or other possible damage.

TIP: See the AssuredSAN 6004 Series Setup Guide for descriptions of rear panel LEDs.

Removing an SFP module
Perform the following procedure to remove an SFP connector. When removing an FC SFP that has 
previously limited the port speed—and replacing it with a higher-rated SFP—it is possible, though rare, that 
auto-negotiation will not enable the higher port speed. Rebooting the array or the host resolves the 
problem. 

1. Disconnect the fibre-optic interface cable by squeezing the end of the cable connector.
If the SFP does not have a cable, it should have a plug (retained from installation).

Figure 55 Disconnect fibre-optic interface cable from SFP

2. SFPs are commonly held in place by a small wire bail actuator. Flip the actuator up.

Figure 56 Flip SFP actuator upwards

3. Grasp the SFP between your thumb and index finger, and carefully remove it from the controller 
module.

Fibre-optic cable attached to SFP

Fibre-optic cable disconnected

Flip actuator/revolve upward
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Installing an SFP module
Perform the following procedure to install an SFP connector.

1. Locate the SFPs that will be used in the CNC ports.
• If the SFP has a plug, remove it before sliding the connector into the CNC port. Retain the plug.
• If using different SFPs in combination, locate the appropriate SFP pertaining to each target CNC 

port, and note the port number (0 — 3) into which each SFP will install.
• See the “Configuring host ports” topic in the Storage Management Guide for information about 

configuring CNC ports for use with qualified FC or iSCSI SFP options.
2. Install the SFP and connect the host interface cable per Figure 57 below:

a. Flip the SFP actuator and revolve it downwards.
b. Insert the SFP into the CNC port and ensure that it locks securely into place.
c. Align the fibre-optic interface cable with the duplex jack at the end of installed SFP.

Figure 57 Install the SFP into the CNC port

3. Connect the fibre-optic interface cable to the duplex jack at the end of the SFP connector.
4. Repeat steps 1—3 for each SFP requiring installation into a CNC port.

TIP: See the “Configuring host ports” topic in the Storage Management Guide for information about 
configuring CNC ports for use with FC or iSCSI host ports.

Verifying component operation
View the Link Status/Link Activity LED on the controller module face plate. A blinking LED indicates that no 
link is detected. Also check the link status and link activity LEDs on the host.

PORT 1

PORT 1

PORT 1

2a 2b

2c

3

Target CNC port on controller module face plate
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Replacing a 10GbE SFP+ transceiver
This section provides steps for removing and replacing a small form-factor pluggable plus (SFP+ 
transceiver) connector used in an Internet SCSI (iSCSI) controller host port. SFP+ connectors are similar in 
appearance to SFP connectors. These transceivers enable 10GbE equipment designs with high port 
density, based on electrical and mechanical enhancements to SFP specifications developed by the Small 
Form Factor (SFF) Committee.

Removing and replacing an SFP+ consists of the same basic steps described for removing and replacing 
an SFP in the preceding section. This procedure refers to the preceding Replacing a Fibre Channel 
transceiver instructions. When reviewing the procedure as it pertains to the 10Gb iSCSI host ports, note 
that your particular cables may be either copper or fibre-optic for the SFP+, depending upon how your 
system was initially configured, and the SFP+ option used.

NOTE: See the controller module — rear panel components topic within the Setup Guide for illustrations 
showing a 10GbE SFP+ installed within the IOM.

Replacing a 1Gb RJ-45 SFP transceiver
This section provides steps for removing and replacing a small form-factor pluggable transceiver connector 
used in an Internet SCSI (iSCSI) controller host port. The copper RJ-45 connectors are similar in 
appearance to other SFP connectors. 

Removing and replacing an RJ-45 SFP consists of the same basic steps described for removing and 
replacing an SFP in the preceding FC and 10GbE iSCSI sections. This procedure refers to Replacing a 
Fibre Channel transceiver on page 67. When reviewing the procedure as it pertains to the 1Gb iSCSI host 
ports, note that this particular SFP does not support an optic option for 1 Gb.

NOTE: See the controller module — rear panel components topic within the Setup Guide for an 
illustration showing an 1 Gb RJ-45 SFP installed within the IOM.

Table 11 Removing and replacing a 10GbE SFP+ transceiver

To accomplish this sequential process See the following procedures

1. Remove SFP+ connector. a. Before you begin on page 67.
b. Verifying component failure on page 68.
c. Removing an SFP module on page 68.

2. Install the replacement SFP+ connector. Installing an SFP module on page 69.

3. Verify proper operation for the removed and 
reinstalled component.

Verifying component operation on page 69.

Table 12 Removing and replacing a 1 Gb SFP transceiver

To accomplish this sequential process See the following procedures

1. Remove SFP connector. a. Before you begin on page 67.
b. Verifying component failure on page 68.
c. Removing an SFP module on page 68.

2. Install the replacement SFP connector. Installing an SFP module on page 69.

3. Verify proper operation for the removed and 
reinstalled component.

Verifying component operation on page 69.
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Replacing a storage enclosure chassis
The controller enclosure or expansion enclosure chassis replacement procedure replaces a damaged 
chassis FRU, which consists of the structural support metal, the exterior sheet metal housing, the 
assembled/installed midplane, and the drawer assemblies. The procedure includes removing all FRU 
components from a damaged chassis and installing them into a replacement chassis.

NOTE: 6004 Series storage enclosures are described in Storage enclosure overview on page 12. 

A fully functional replacement chassis requires the successful removal and installation of the following 
components:

• Enclosure bezel (covers enclosure front panel)
• All disk drive modules
• AMS inserts installed in drawers (2U48 only)
• Ear components
• Two power supply units of the same type (both AC or both DC). Both AC for 2U48 enclosures.
• Two fan control modules (4U56 only)
• One or two I/O modules (of the same model type)

CNC models require the successful removal and installation of qualified SFP options. This procedure makes 
extensive use of the FRU component procedures described elsewhere in Chapter 2.

Before you begin

IMPORTANT: For 4U56 enclosures, retain original packaging materials for use with returns. For returns, 
the chassis master container must ship on a pallet (non-compliance could void warranty).

CAUTION: Do not remove the enclosure until you have received the replacement enclosure.

See the CAUTION bullets regarding “electrostatic discharge” and “anti-static protection” on page 23.

1. Schedule down time that will allow for shutdown; sixty minutes of replacement work; and restart.
2. Verify the existence of a known/good backup of the system.
3. Record system settings for future use and label all cables.
4. Prepare a suitable static-protected work environment to accommodate chassis replacement.

Verifying component failure
The controller enclosure FRU includes the enclosure’s metal housing and the midplane that connects I/O 
modules, power supply modules, and the igus chain-flex subassemblies for communicating with PCBAs 
installed in the drawers (disks are installed separately). This chassis FRU replaces an enclosure that has 
been damaged, or whose midplane has been damaged. Often, a damaged midplane will appear as 
though an I/O module has failed. If you replace an IOM, and it does not remedy the fault, you may need 
to replace the enclosure. 

You can observe enclosure health (front panel and rear panel) using management interfaces to verify 
enclosure/component failure or enclosure/component operation (see Using management interfaces on 
page 75 for more information).
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Preparing to remove a damaged storage enclosure chassis
Because you are removing and replacing an entire storage enclosure, neither the hot-swap capability that 
applies to replacing individual redundant FRUs in an operational storage enclosure, nor the hot-add of a 
drive enclosure to an operational storage system, apply to this procedure.

1. Stop all I/O from hosts to the system. See Stopping I/O on page 29.
2. Shut down the controllers. See Shutting down a controller module on page 29.
3. Power off the system (controller enclosure first; expansion enclosures next). See Power supply units on 

page 52.

Table 13 Removing and replacing a storage enclosure chassis and its FRUs

To accomplish this sequential process See the following procedures

1. Remove the enclosure bezel to provide access to 
front panel components.

a. Removing the enclosure bezel (2U) on page 25, or
b. Removing the enclosure bezel (4U) on page 26

2. Remove disk modules from the damaged chassis1 
(2U48 chassis: upon completion proceed to step 4)

a. Before you begin on page 44.
b. Accessing a 2U16 drawer on page 37
c. Removing a disk drive module (2U48) on 

page 44.

3. Remove disk modules from the damaged chassis1 
(4U56 chassis: upon completion proceed to step 4)

a. Before you begin on page 44.
b. Accessing a 4U28 drawer on page 39
a. Removing a disk drive module (4U56) on 

page 45.

4. Remove the ear components from the damaged 
chassis.

a. Before you begin on page 63.
b. Removing ear components on page 66.

5. Remove power and data cables. Removing a damaged storage enclosure chassis 
from the rack on page 73 (step 1).

6. Remove the damaged storage enclosure chassis 
from the rack.

Removing a damaged storage enclosure chassis from the 
rack on page 73.

7. Remove the power supply units from the damaged 
chassis, and install them in the replacement 
chassis.

a. Before you begin on page 50.
b. Power supply units on page 52.
c. Removing a power supply unit (2U48) on 

page 54.
d. Installing a power supply unit (2U48) on page 55.

8. Remove the fan control modules from the damaged 
chassis, and install them in the replacement chassis 
(4U56 chassis only).

a. Before you begin on page 59
b. Removing a fan control module on page 61
c. Installing a fan control module on page 62

9. Remove each IOM from the damaged chassis, and 
install it in the replacement chassis.2

a. Before you begin on page 27.
b. Removing a controller module or expansion module 

on page 31.
c. Installing a controller module or expansion module 

on page 33.

10.Remove each FC SFP from the damaged chassis, 
and install it in the replacement chassis (Fibre 
Channel models only).3

a. Before you begin on page 67.
b. Removing an SFP module on page 68.
c. Installing an SFP module on page 69.

11.Remove each 10GbE SFP from the damaged 
chassis, and install it in the replacement chassis 
(10GbE iSCSI models only).3

Replacing a 10GbE SFP+ transceiver on page 70. 
Also see Steps 8a — 8c immediately above.

12.Remove each 1 Gb SFP from the damaged chassis, 
and install it in the replacement chassis
(1 Gb iSCSI models only).3

Replacing a 1Gb RJ-45 SFP transceiver on page 70.
Also see Steps 8a — 8c above.
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1Within the replacement enclosure, reinstall each disk into the same drawer slot from which it was extracted from the damaged enclosure.
2Within the replacement enclosure, the IOM(s) must be reinstalled into the same IOM slots from which they were extracted from the 

damaged enclosure.
3If your enclosure model does not use CNC ports, ignore this step.

Removing a damaged storage enclosure chassis from the rack
This section provides a procedure for removing a damaged storage enclosure chassis from its rack 
location.

CAUTION: It is recommended that all enclosure disks be removed before removing the enclosure. Two 
people are required to move the enclosure. See Removing the enclosure bezel (4U) on page 26; Opening 
and closing a 4U28 drawer on page 39; and FDE considerations on page 41.

1. Disconnect the power cables and data cables between devices as needed:
a. Between the cascaded enclosures.
b. Between the controller and peripheral SAN devices.
c. Between the controller and the host.

2. Make sure the ear components are removed. See Removing ear components on page 66.
3. Remove the retaining screws that secure the front and rear of the enclosure chassis to the rack and rails.
4. Maintaining a level position, carefully slide the enclosure chassis from the rack.
5. Place the chassis on a work surface near the replacement enclosure chassis, the removed disk drive 

modules, ear components, and screws.
6. Remove the side bracket from each side of the damaged enclosure chassis, and retain these rackmount 

items with the other components for future use.

Installing the replacement storage enclosure in the rack
This section provides a procedure for installing the replacement enclosure in its rack location.

13. Install ear kit components on the replacement 
chassis.

Installing ear kit components on page 66.

14. Install the replacement storage enclosure chassis in 
the rack. 

Installing the replacement storage enclosure in the rack on 
page 73.

15. Install disks into appropriate drawer slots in the 
replacement chassis.1

a. Installing a disk drive module (2U48) on 
page 46

b. Installing a disk drive module (4U56) on page 47
c. FDE considerations on page 41.

16.Complete the installation process. a. Connecting a power cable on page 57.
b. Completing the process on page 74.

17. Verify proper operation for all removed and 
installed FRU components.

a. Disks—Verifying component operation on page 50.
b. IOMs—Verifying component operation on 

page 35.
c. PSUs—Verifying component operation (2U) on 

page 58.
d. SFPs (if applicable)—Verifying component 

operation on page 69.
e. Verify PFU enabled (if applicable)—Configuring 

partner firmware update on page 27.

Table 13 Removing and replacing a storage enclosure chassis and its FRUs (continued)

To accomplish this sequential process See the following procedures
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CAUTION: It is recommended that all enclosure disks be removed before lifting the enclosure. Two people 
are required to move the enclosure.

NOTE: Refer to Rackmount Bracket Kit Installation used with your product for the correct procedure and 
mounting hardware.

1. Attach side brackets on the replacement enclosure chassis.
2. Support the bottom of the enclosure chassis. Carefully lift/align the chassis and while maintaining a 

level position for the enclosure, slide it into the rack.
3. Using the appropriate mounting hardware, secure the enclosure chassis to the rack.
4. Install the ear components. See Installing ear kit components on page 66.
5. Using the applicable retaining screws, secure the front and rear or the enclosure chassis to the rack and 

rails.
6. Attach the enclosure bezel to the front panel of the enclosure:

See Attaching and removing the enclosure bezel on page 25 (Figure 15) for bezel attachment and 
removal details.

Completing the process
This section provides a procedure for ensuring that the FRU components installed in the replacement 
controller enclosure chassis function properly.

1. Reconnect data cables between devices, as needed, to return to the original cabling configuration:
• Between cascaded enclosures.
• Between the controller and peripheral or SAN devices.
• Between the controller enclosure and the host.

2. Reconnect power cables to the controller enclosure. See Connecting a power cable on page 57.
3. Turn on the power switch for each power supply module.

Verifying component operation
1. Restart system devices in the following sequence. Allow time for each device to complete its Power On 

Self Tests (POST) before proceeding:
a. Expansion enclosure(s)
b. Controller enclosure
c. Host (if powered down for maintenance)

2. Perform a rescan to force a fresh discovery of all expansion enclosures connected to the controller 
enclosure. This step clears the internal SAS layout information, reassigns enclosure IDs, and ensures the 
enclosures are displayed in the proper order. Use the CLI, the SMC, or RAIDar to perform the rescan:
To perform a rescan using the CLI, enter the following command:

rescan

You can set a CLI preference to use v3 commands to manage virtual storage or to use v2 commands to 
manage linear storage.
See the TIP bullets regarding CLI “default management mode” and “current management mode” 
page 28.
To rescan using the SMC (v3):
a. Verify that both controllers are operating normally.
b. Do one of the following:

• Point to the System tab and select Rescan Disk Channels.
• In the System topic, select Action > Rescan Disk Channels.
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c. Click Rescan.
To rescan using RAIDar (v2):
a. Verify that the controllers are operating normally.
b. In the Configuration View panel, right-click the system and select Tools > Rescan Disk Channels.
c. Click Rescan.
See “Correcting enclosure IDs” in the Setup Guide for additional information.

Using LEDs
View LEDs on the front and rear of the enclosure (see “LED descriptions” within the AssuredSAN 6004 
Series Setup Guide for more information).

Verify front panel LEDs:

• Verify that the Enclosure ID LED (located on the left ear) is illuminated green.
• Verify that the FRU OK and Temperature Fault LEDs are illuminated green, and that the Fault/Service 

Required LED is off (all three LEDs are located on the right ear).
• Verify that the drawer OK LED is illuminated green (top LED located on drawer front panel).
• For SFF disks, verify that the Power/Activity LED (single bi-color LED on front of disk) is illuminated 

green or blinking green.
Remove the enclosure bezel and open the target drawer to view disk LEDs. Close the drawer and 
re-attach the bezel when finished viewing disk LEDs.

Verify rear panel LEDs:

• Verify that each power supply module’s Input Source Power Good LED (top LED on PSU) is illuminated 
green.

• Verify that the FRU OK LED on each fan control module is illuminated green, indicating that the module 
power is on with at least one fan operating normally.

• Verify that the FRU OK LED on each IOM face plate is illuminated green, indicating that the module 
has completed initializing, and is online.

Using management interfaces
In addition to viewing LEDs as described above, you can use management interfaces to monitor the health 
status of the system and its components, provided you have configured and provisioned the system, and 
enabled event notification (see “Getting Started” within the AssuredSAN Storage Management Guide for 
more information). 

Select from the following methods to verify component operation:

• Use the SMC (v3) or RAIDar (v2) to check the health icons/values of the system and its components to 
either ensure that everything is okay, or to drill down to a problem component. The SMC and RAIDar 
use health icons to show OK, Degraded, Fault, or Unknown status for the system and its components. If 
you discover a problem component, follow the actions in its Health Recommendations field to resolve 
the problem.

• As an alternative to using the SMC or RAIDar, you can run the show system command in the CLI to 
view the health of the system and its components. If any component has a problem, the system health 
will be Degraded, Fault, or Unknown. If you discover a problem component, follow the actions in its 
Health Recommendations field to resolve the problem.

• Monitor event notification — With event notification configured and enabled, you can view event logs 
to monitor the health of the system and its components. If a message tells you to check whether an event 
has been logged, or to view information about an event in the log, you can do so using the SMC, 
RAIDar, or the CLI. Using either the SMC or RAIDar, you would view the event log and then hover over 
the event message to see detail about that event. Using the CLI, you would run the show events 
detail command (with additional parameters to filter the output) to see the detail for an event (see 
“Alphabetical list of commands > show events” within the AssuredSAN CLI Reference Guide for more 
information about command syntax and parameters).
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A Drawer description for 2U48 chassis
This appendix provides reference information complementing the information provided in the FRUs chapter 
and in the procedure entitled Accessing a 2U16 drawer on page 37.

Drawer configuration
To gain access to the 2U48 enclosure drawers, you must first remove the enclosure bezel as described in 
Figure 7 on page 19. To see the contents of a drawer, flip the handle upwards, and pull the drawer 
outward from the enclosure drawer bay as described in Opening and closing a 2U16 drawer on page 37. 

Drawer pictorials are provided for the two enclosure drawer types in Figure 58. Drawer 0 and Drawer 1 
use the same sub-assembly. Each drawer contains four disk bays, and each disk bay can accommodate 
four disks.

Figure 58 Enclosure front face pictorial featuring 2U16 drawers

Diagrams of the three drawer front panels with corresponding revolved side views showing disk slot 
numbering are provided in Figure 59. Drawers 0 and 1 provide access to disk bays on the right side of the 
drawer, whereas Drawer 2 provides access to disk bays on the left side of the drawer.

Figure 59 Schematic representation of drawers (2U48)

Loading requirements
See Installing a disk drive module (2U48) on page 46 for instructions about installing a sledded-disk into a 
slot within a bay in the enclosure drawer. See Air management in disk drive slots on page 42 for 
instructions about removing or installing an AMS into a disk bay in the enclosure drawer. Be mindful of 
these drawer loading requirements.

• Install your sledded-disks into the drawer slots in multiples of four disk drive modules.

0 1 2

Drawer 2Drawer 1

Note: The enclosure bezel is removed to reveal the front panel; the bezel must be attached during operation.

Drawer 0

Drawer Profiles
Disk bays with sequentially−numbered disk slots

Right side view
(Revolved Y −90°)

Left side view
(Revolved Y +90°)
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(Revolved Y −90°)
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Note: Drawer 0 and 1 show right side views for disk bays and slots; whereas Drawer 2 shows a left side view.
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For example, in disk bay1 of Drawer 0, install disk modules into slots 0,1,2, and 3 before populating 
disk bay 2, followed by disk bay 3, and disk bay 4.

IMPORTANT: Disk drive slot numbering is provided on the label that is applied to the sheet metal 
(top face) on each drawer. Refer to the label when installing disks.

• Drawers use self-encrypting disk (SED) drives (see FDE considerations on page 41).
• Install an AMS insert into any unpopulated disk drive bay.

A single blank installs into the drawer bay such that it covers four vertically-adjacent disk drive slots 
(see Installing an AMS into a 2U16 drawer on page 42).

IMPORTANT: Empty bays will cause overheating. To avoid overheating, install an AMS insert in 
empty bays (see Figure 60) or individual disk slots (see Figure 30 on page 43).

Figure 60 below provides a sample partial configuration of disk bays within a drawer. The bay on the left 
is populated with four disks, whereas the adjacent bay on the right contains an AMS insert to manage 
flow within the enclosure to maintain optimal operating temperature.

Figure 60 2U48 enclosure: sample disk bay population

Figure 61 below shows sample drawer population of the two different drawers used in the 2U48 
enclosures. The left-hand (LH) drawer sub-assembly is used for Drawers 0 and 1, and the right-hand (RH) 
drawer sub-assembly is used for Drawer 2.

Figure 61 2U48 enclosure: sample drawer population

Disks and AMS installed in drive slots

2.5" SFF disk drive module pictorial AMS insert pictorialPartial side view of 2U48 drawer

Left-hand drawer pictorial featuring 16-disks Right-hand drawer pictorial featuring 16-disks

AMS insert installed in RH drawerAMS insert installed in LH drawer
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LED descriptions for drawer components
Drawer front panel LEDs

In Figure 62 below, the enclosure bezel has been removed, and the ears have been cropped to show only 
the front panels of the three disk drawers. The disk drawers are shown with pull-handles in stowed position. 
To open a drawer, first loosen the thumb wheel and then rotate the pull-handle upwards by 90 as shown 
in Figure 59 on page 76. Each drawer front panel features a set of LEDs describing system behavior at the 
drawer-status level.

Figure 62 LEDs: 2U48 drawer status front panel layout

NOTE: If all drawer panel LEDs are off—but the enclosure is powered on—the drawer is not powered on.

Disk LED
In Figure 63 on page 79, an individual disk drive module is shown and its LED behavior is summarized. To 
view the disk module LEDs, you must first open the drawer containing the disks you wish to view (see 
Opening and closing a 2U16 drawer on page 37). Disk drive slot numbering is provided on the label 
affixed to the top face of each drawer.

Alternatively, you can use the SMC or RAIDar to check the health icons/values for the system and its 
components to ensure that everything is okay, or to drill down to a problem component. If you discover a 
problem, the SMC, RAIDar, and the CLI provide recommended-action text online.

LED No./Description Color State Definition

1— FRU OK Green On

Blink

Off

The drawer is operating normally.

The drawer is initializing or the system is booting.

If not illuminated and Fault is not illuminated, the drawer is not 
online. Otherwise, the drawer is not OK.

2— Fault/Service Required Amber On

Blink

A drawer-level fault is detected or a service action is required.

Hardware-controlled power-up.

3— OK to Remove Blue On

Off

The drawer is prepared for removal.

The drawer is not prepared for removal.

4— Unit Locator White Off

Blink

Normal operation.

Physically identifies the disk drawer.

Drawer Front Panels (Sequentially−numbered from left to right)

1 20

2 31 4
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1Given that the blue behavior (state) of the LED can indicate only one state at a time, the precedence of requests from highest to 
lowest is as follows: Identify; Fault; OK to remove. A higher precedence indication can hide a lower precedence indication.

Figure 63 LED: 2U48 disk drive module

LED mode description Color State Definition

Removal/Identification/Fault Blue1 On

1Hz Blink

4Hz Blink

Off

The disk drive is prepared for removal.

Physically identifies the disk drive module.

The disk has failed; experienced a fault; is a leftover; or the 
disk group that it is associated with is down or critical.

No fault, identify, or remove requests are active.

Power/Activity Green On

Blink

Off

The disk drive module is operating normally.

The disk drive module is initializing; active and processing I/O; 
performing a media scan; or the disk group is initializing or 
reconstructing.

The disk drive is not powered on.

Disk aligned for Drawer 0 or 1

2.5" SFF disk drive module
(see table below for LED behaviors)

Bi-color LED Bi-color LED

Disk aligned for Drawer 2
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B Drawer description for 4U56 chassis
This appendix provides reference information complementing the information provided in the FRUs chapter 
and in the procedure entitled Accessing a 4U28 drawer on page 39.

Drawer configuration
To gain access to the 4U56 enclosure drawers, you must first remove the enclosure bezel as described in 
Figure 15 on page 26. To see the contents of a drawer, flip the handle downwards, and pull the drawer 
outward from the enclosure drawer bay as described in Opening and closing a 4U28 drawer on page 39. 

Drawer pictorials are provided for the two enclosure drawers in Figure 64. Each drawer contains four disk 
bays, and each disk bay can accommodate seven disks.

Figure 64 Enclosure front face pictorial featuring drawers (4U56)

Diagrams of the two drawer front panels with corresponding revolved side views showing disk slot 
numbering are provided in Figure 65. Drawers 0 and 1 provide access to disk bays on the top of the 
drawer.

Figure 65 Schematic representation of drawers (4U56)

Left ear Right ear

Note: Bezel is removed and rails are not installed in this view.

DRAWER 0 DRIVES 0 − 27
PN: 21−00000590−00−01 rev A

DRAWER 1 DRIVES 28 − 55
PN: 21−00000590−00−02 rev A

PN: 21−00000590−00−02 rev A

0 28

1 29

2 30

3 31

4 32

5 33

34

7 35

8 36

9 37

10 38

11 39

12 40

41

42

15 43

16 44

17 45

18 46

19 47

48

49

22 50

23 51

23 52

25 53

26 54

55

14 21

2720136

A

B

C

Front view

Top view

Right side view

Diagram legend:A

Drawer multiviews
Disk rows with sequentially−numbered disk slots

B

C
0 31 2

0 31 2

D0

D1

Drawer 0 slot numbers

Drawer 1 slot numbers

Key: drawer/row/slot numbering

n
n Disk row numbers

45° orthographic bisector

Revolve
handle
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Loading requirements
See Installing a disk drive module (4U56) on page 47 for instructions about installing a sledded disk into a 
slot within a bay in the enclosure drawer. Be mindful of these drawer loading requirements.

• Install your sledded disks into the drawer slots in multiples of seven disk drive modules.
For example, in disk bay 3 of Drawer 0, install disk modules into slots 21—27 before populating disk 
bay 2, followed by disk bay 1, and disk bay 0.

IMPORTANT: Drawer and disk slot numbering are described pictorially on the adhesive label 
laminated to the exterior wall of each drawer. Refer to the label when installing disks.

IMPORTANT: If you are completely filling a drawer with disk modules, populate from back row to 
front row, while installing disks into the slots. Provide adequate support for the weight of the 
extended drawer as you install the disks.
If you are installing disk modules to partially fill a drawer, you must install a minimum of 14 disk 
modules, and they must be placed in contiguous slots closest to the front of the drawer.

• Drawers use self-encrypting disk (SED) drives (see FDE considerations on page 41).

LED descriptions for drawer components
Drawer front panel LEDs

In Figure 66 below, the enclosure bezel has been removed, and the ears have been cropped to show only 
the front panels of the three disk drawers. The disk drawers are shown with pull-handles in stowed position. 
To open a drawer, first loosen the thumb wheel and then rotate the pull-handle upwards by 90 as shown 
in Figure 65 on page 80. Each drawer front panel features a set of LEDs describing system behavior at the 
drawer-status level.

DRAWER 0 DRIVES 0 − 27
PN: 21−00000590−00−01 rev A

DRAWER 1 DRIVES 28 − 55
PN: 21−00000590−00−02 rev A

Left ear Right ear

1 2 3 4 5 1Note: Bezel is removed and rails are not installed in this view.

LED Description Definition

1 Enclosure ear LEDs Enclosure ear LEDs (see Figure 53 on page 65).

2 Unit Locator White blink — Enclosure is identified
Off — Normal operation

3 OK to Remove Blue — On
The drawer is prepared for removal.
Off — The drawer is not prepared for removal.
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Figure 66 LEDs: 4U56 drawer status front panel layout (continued)

NOTE: If all drawer panel LEDs are off—but the enclosure is powered on—the drawer is not powered on.

Disk LEDs
In Figure 67 on page 83, an individual disk drive module is shown and its LED behavior is summarized. To 
view the disk module LEDs, you must first open the drawer containing the disks you wish to view (see 
Opening and closing a 4U28 drawer on page 39). Disk drive slot numbering is provided on the label 
affixed to the exterior of each drawer.

Alternatively, you can use the SMC or RAIDar to check the health icons/values for the system and its 
components to ensure that everything is okay, or to drill down to a problem component. If you discover a 
problem, the SMC, RAIDar, and the CLI provide recommended-action text online.

4 Fault/Service Required Amber — On
Drawer-level fault condition exists. The event has been acknowledged but 
the problem needs attention.
Amber — Blink
Hardware-controlled power-up.
Off — No fault condition exists.

5 FRU OK Green — On
The drawer is powered on with the power supply operating normally.
Green — blink 
The drawer is initializing.
Off — The drawer is not OK.

LED Description Definition
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Figure 67 LED: 4U56 disk drive module

LED mode description Color State Definition

1—Power/Activity Green On

Blink

Off

The disk drive is operating normally.

The disk drive module is initializing; active and processing I/O; 
performing a media scan; or the vdisk or disk group is 
initializing or reconstructing.

No identify or remove requests are active. If not illuminated 
and Fault is not illuminated, the disk is not powered on.

2—Fault Amber On

Blink

Off

The disk has failed; experienced a fault; is a leftover; or the 
disk group that it is associated with is down or critical.

Physically identifies the disk; or locates a leftover (also see Blue).

If not illuminated and Power/Activity is not illuminated, the 
disk is not powered on.

Blue Blink Leftover disk from disk group is located (alternates blinking 
amber).

3.5" LFF disk drive module
(see table below for LED behaviors)

1

LEDs

2

Electromagnetic interference protection for disks is provided by the EMI shield in the enclosure bezel.

Front view of sledded disk

Disk module oriented for insertion into drawer
(PCBA connector is visible at base of module)
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